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1 Introduction

The HP Capture and Route (HP CR) Installation Guide contains instructions for installing and configuring 
HP Capture and Route (HP CR), an enterprise solution. The guide is written for system administrators who 
have detailed knowledge of the Windows operating system and LANs. 

This section describes:

HP Capture and Route overview (3)

Built-in HP CR server features (4)

Clients and specialized integrations (4)

Server deployment summary (5)

Online help and related documentation (6)

1-1 HP Capture and Route overview
HP Capture and Route (HP CR) is a server-based software application for document capture, which 
operates on a Microsoft Windows server within a customer’s network. Users can access HP CR’s 
document capture and routing capabilities from any scan-enabled MFP or network-connected scanner. HP 
CR converts captured documents into a variety of image- and text-based document formats and delivers 
them to a wide range of destinations.

Documents are transferred from a web-based End User Interface, MFP, or network scanner to the HP CR 
server, which processes and delivers them to specified destinations. If the device used to scan a document 
is an HP device enabled with the HP OXPd embedded platform, and the capture function or document 
process requires it, the user may be prompted at the time of scanning to enter indexing metadata or 
recipient addressing information. Certain document processes may also specify that a user receive 
notification upon final job delivery through the system. Notification messages can be sent to the scanning 
user’s email address, or as a confirmation page printed back to the source scan device, if that device is an 
MFP and capable of printing these confirmations.

1-1-1 Scalability and automated failover
HP CR is a highly scalable enterprise application that can be deployed in organizations of all sizes. Its 
robust server-client architecture supports distributed workloads, versatile throughput, and unmatched 
document distribution capabilities using numerous delivery systems and methods.

With smaller workloads, the HP CR server can suitably perform all the functions required for document 
distribution. As an organization grows, the server workload can be distributed or completely off-loaded 
using one or all of the following components:

 Remote Administrator - A remote system hosting HP CR Server Administrator, which is the HP CR 
server management application. (See Section 5: Installing a Remote Administrator, 51.)

 Remote Compose (Composer) - A remote system hosting a Composer, which performs document 
conversion tasks. (See Section 6: Installing a remote Composer, 55.)

 Remote Modem Server - A remote system hosting a modem server. (See Section 7: Installing a 
remote modem server, 61.)

 Remote Intelligent Device Client - A remote system hosting an HP CR Intelligent Device Client. 
(See Section 8: Installing the Remote HP CR Intelligent Device Client, 69.)
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 Secondary Server - A secondary system in a failover configuration. (See Section 15: Setting up an 
HP CR Server Cluster, 131.)

In addition to scalability, the HP CR solution supports automated failover. In case of a system failure on 
the HP CR server, automated failover promises seamless recovery using a standby server.

1-2 Built-in HP CR server features
The HP CR server includes these built-in features: 

 Centralized administration - You can manage an HP CR server using the HP CR Server 
Administrator, a snap-in for Microsoft Management Console. After connecting the HP CR Server 
Administrator to your HP CR server in the LAN, you can:

 Modify the configuration of server components

 Manage the server connectors

 Manage user permissions and feature access

 Monitor message processing

 Manipulate rules for handling inbound and outbound messages

 Troubleshoot errors

 Automated self-maintenance - You can manage the HP CR server databases using the 
Maintenance component. You can configure the Maintenance component Cleanup feature to 
remove messages and archive entries from the database after a specified length of time. You can 
also configure the Archive feature to copy messages to an archive database and remove the 
messages from the archive after a specified length of time.

 Customized document workflow - You can create rules to determine how the HP CR server will 
process inbound and outbound messages. The rules are highly configurable and can be 
manipulated to achieve specific results.

 Configurable user permissions and feature access - You can create Groups and configure user 
permissions in the HP CR Server Administrator. The collection of group records determines the 
access privilege of each user to the HP CR End User Interface and Preview. (Preview is a 
configurable feature that makes a user’s messages available for preview before they are sent.) The 
user default configuration applies globally to users who do not require special permissions or feature 
access.

1-3 Clients and specialized integrations
HP CR features are accessible where the users need them most—on the web, office machines, 
multifunction devices, and business systems that are an integral part of the communication workflow. 

HP CR is an intranet-based application for:

 Multifunction devices and business systems - Supports software solutions complementing the 
hardware solutions offered by Hewlett Packard as well as integrating with other vendor devices such 
as Ricoh Corporation, Sharp Electronics Corporation, and Xerox Corporation.

NOTE:  HP CR server does not support HP Chai Device Client. If you are using Chai and are installing HP 
CR in your environment, install the Embedded Device Client for HP OXPd v1.4 available in the server 
clients directory. For download, installation, and configuration instructions, refer to the HP Capture and 
Route (HP CR) Embedded Device Client for HP OXPd Installation Guide.

http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf
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NOTE:  When scanning from Ricoh devices, users must choose Multi-paged PDF in the scan options of 
the device.

 Document and records management systems - HP CR integrates with document and records 
management solutions including Microsoft® SharePoint®, FileShare, and iManage (limited support 
for iManage versions; verify that your version is supported before using).

NOTE:  Support for iManage is limited to the following versions in the HP Capture and Route v1.5.0 Server:
- FileSite v8.5 – v9.0
- DeskSite v8.5- v9.0

Refer to Section 17: Software integrations (153) and the HP Capture and Route (HP CR) Embedded 
Device Client for HP OXPd Installation Guide for more information.

1-4 Localized clients and device buttons
The HP CR End User Interface, device clients, and standard device buttons have been localized for 
Simplified Chinese, French, German, Italian, Brazilian Portuguese, and Spanish. Localization includes:

 HP CR Web User Interface and the HP Capture and Route (HP CR) User Guide.

 HP CR Legacy Web User Interface and the HP Capture and Route (HP CR) User Guide.

 HP CR Embedded Device Client and the associated Quick Start Guide.

 HP CR for HP OXPd v1.4 Device Client and the associated Quick Start Guide.

 HP CR for Microsoft SharePoint and the associated Quick Start Guide.

 iManage and the associated Quick Start Guide.

Standard device buttons have been localized. Note, however, that the Administrator can modify the text as 
it appears on a device button. These buttons will not appear as localized unless the Administrator enters 
the text in the applicable language.

1-5 Server deployment summary
To deploy the HP CR server:

1. Complete the installation requirements using the guidelines provided in Section 2: Requirements (7).

2. Install the HP CR server using the instructions in Section 3: Installing the HP CR server (11).

3. Perform required configurations using the instructions in Section 4: HP CR Server Administrator 
overview and post-installation configuration (23).

4. Set up SMTP integration. Refer to the SMTP connector information in the HP CR administrator 
online help for instructions.

5. Set up other server-side related features such as:

 Remote Administrator (Section 5: Installing a Remote Administrator, 51)

 Remote Composer (Section 6: Installing a remote Composer, 55)

 Remote Modem Server (Section 7: Installing a remote modem server, 61)

 Remote HP CR Intelligent Device Client (Section 8: Installing the Remote HP CR Intelligent 
Device Client, 69)

http://www.omtool.com/documentation/hpcr/1.4.0/admin/index.htm

http://www.omtool.com/documentation/hpcr/1.4.0/admin/index.htm

http://www.omtool.com/documentation/hpcr/1.5.0/quickstart/hpcr_embeddeddeviceclientquickstarts.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/quickstart/hpsharepointquickstarts.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/webclient/webclient_en.pdf
http://www.omtool.com/documentation/hpcr/1.4.0/quickstart/hpcrworksitequickstarts.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/quickstart/hpoxp1.4quickstarts.pdf
http://www.omtool.com/documentation/hpcr/1.4.0/quickstart/hpcrworksitequickstarts.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/webapps/webapps_en.pdf
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6. Set up the HP CR End User Interface where users can create Distribution Rules. Refer to Section 
10: HP CR End User Interface (77). In addition, see the HP CR User Guide, which contains links to 
the HP CR End User Interface and all other related documentation for the HP CR server.

1-6 Online help and related documentation
Click the Help button at any time to access HP CR online documentation.

Refer also to the HP Capture and Route v1.5.0 Release Notes.

http://www.omtool.com/documentation/hpcr/1.5.0/webclient/webclient_en.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/hpcr1.5.0_releasenotes.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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2 Requirements

The streamlined HP CR Server installation and configuration process automates a series of verification, 
installation, and configuration tasks. However, before you can install the HP CR server on a system, you 
need to make some initial server configurations and assure hardware and software requirements are met. 

This section discusses the hardware and software requirements for the HP CR server installation, as well 
as the required server configurations.

For more information on the automated pre- and post-installation tasks handled by the installation process, 
refer to Automated pre- and post-installation and configuration tasks (11).

This section describes the following:

Hardware and software requirements (7)

Creating the HP CR service account (9)

Creating the HP CR Admins group (9)

Installing Microsoft SQL Express on the HP CR server (10)

2-1 Hardware and software requirements
The HP CR server installation requires a dedicated system that meets the following minimum 
requirements:

 Dual core processor, 2 GHz, 4GB of RAM, RAID 5W with 100 GB of disk space, and Microsoft 
mouse or compatible pointing device.

NOTE:  Hardware requirements are subject to change based on the configuration of implementation.

 Windows 2012 64-bit, Windows 2008 R2 SP-1 64-bit

 Windows Active Directory - HP CR can only be installed in a Windows Active Directory environment. 
All server security and authentications are dependent on the Active Directory authentication.

 Microsoft.Net Framework:

 MS.Net 4.6.1 is required to install the HP CR Server.

NOTE:  The installation includes MS.Net 4.6.1, if not currently installed.

 MS.Net 3.5.1 is required to install the Embedded Device Client, the Intelligent Device Client, 
and the End User Interface. 

NOTE:  In a Windows 2012 environment, MS.Net 3.5.1 is not included or configured with the pre-
installation pack. As a requirement for Device Client installations, you need to independently download and 
install MS.Net 3.5.1 to your Windows 2012 system.

 Microsoft Internet Explorer 11, or later

 Acrobat Reader 9.0 or 11.0 or later

 Internet connection (required for installing Microsoft.Net and for using cloud-based Folders)
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IMPORTANT:  Do not run any other enterprise application on the HP CR server.

2-1-1 Supported devices
HP CR supports the Embedded Device Client for HP OXPd on many devices. Refer to the HP Capture and 
Route (HP CR) Embedded Device Client for HP OXPd Installation Guide for a current and comprehensive 
list of supported devices.

For information on the supported devices for HP OXPd v1.6 and v1.4, refer to the HP CR Embedded 
Device Client for HP OXPd Installation Guide.

2-1-2 Additional installation requirements
An HP CR server installation also requires the following:

 HP CR service account. For instructions to create the HP CR service account, see Creating the HP 
CR service account (9).

 Windows user account that belongs to the local Administrators group. For instructions to create this 
group, see Creating the HP CR Admins group (9).

 Installed MS SQL application. For instructions, see Installing Microsoft SQL Express on the HP CR 
server (10). If undetected during the automated prerequisites check, a minimum version of Microsoft 
SQL is automatically installed.

 (Optional) Installed, configured, and tested fax module for an HP CR server that supports faxing. Fax 
options are installed (or planned out) if faxing is going to be used in the HP CR environment. Faxing 
is available through the Telco, T37 SMTP, or HP Lanfax connector, depending on your environment. 
For information on modem installation, consult the fax connector options in the HP CR administrator 
online help.

 Windows firewall settings: Turning off the firewall will allow exceptions for the mmc.exe and the 
DCOM port (135). If you do not want to turn off the Windows firewall, keep the firewall on and allow 
the DCOM port (135) and mmc.exe.

NOTE:  If the firewall is on and you do not allow the DCOM port (135) and mmc.exe, you will get the 
following message when you try to open the HP CR Server Administrator after installing the server: 
0x800706ba) The RPC server is unavailable.

http://www.omtool.com/documentation/hpcr/1.5.0/serverhelp/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/serverhelp/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/embeddedhpcrdeviceclientforhpoxpd.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/embeddedhpcrdeviceclientforhpoxpd.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf
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2-1-3 Additional software considerations for a composer
The HP CR server setup automatically installs a local Composer on the server. This is needed to compose 
documents into the specified final formats.

A remote Composer is available (see Section 6: Installing a remote Composer (55) for details). The local 
and remote Composer must have the following applications installed if using the native application to 
convert documents. For example, if you are planning to use Crystal Reports for composing, then Crystal 
Reports must be installed on the compose server. 

 Microsoft Visio 2007 for *.VSD and *.VDX message attachments (required)

 Crystal Reports v10.0 or earlier for *.RPT message attachments (required)

 Microsoft Office 2007 or higher for *.DOC, *.DOCX, *.PPT, *.PPTX, *.XLS, and *.XLSX message 
attachments (recommended, but not required)

 Microsoft Word 2007 or higher for *.DOC Routing Sheet templates

IMPORTANT:  After installing Microsoft Word, you must open a Word document and register the software. 
You must also verify that pop-ups do not appear, to ensure successful composition of messages in the HP 
CR server.

NOTE:  Routing Sheet templates are provided in *.DOC and *.OMTPL format. These templates can be 
edited in Word and WordPad, respectively.

If multiple versions of an application are deployed in the LAN, the most recent version must be installed on 
the Composer. For example, if Office 2010 and 2007 are deployed, then Office 2010 must be installed on 
the Composer.

2-2 Creating the HP CR service account
The HP CR service account is a dedicated Windows user account designed to run services on the HP CR 
server.

IMPORTANT:  It is strongly recommended that you do not change this account or the password associated 
with it. 

The HP CR service account user must:

 belong to the Domain Users group in the domain where the HP CR server is being installed.

 belong to the local Administrators group on the system where the HP CR server is being installed.

 have a password that never expires.

You can create or select a Windows user account as the HP CR service account. For instructions on 
creating Windows user accounts, consult Windows help.

2-3 Creating the HP CR Admins group
The Admins group consists of all HP CR users who run the HP CR Server Administrator (either on the HP 
CR Server or Remote Administrator). These users must have Distributed COM access, launch, and 
configuration permissions on the HP CR server. 
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To create an HP CR Admins group: 

1. Go to the Active Directory or LDAP. Locate the domain where the HP CR server is being installed.

2. Create a group for HP CR Server Administrator users. Name this group HP CR Admins.

3. Add all users who will run the HP CR Server Administrator to the HP CR Admins group. 

4. Log in to the system where the HP CR server is being installed using an account that belongs to the 
local Administrators group.

5. Add the HP CR Admins group to the local Administrators group.

When you need to add additional users to run the HP CR Server Administrator, you can add them to the 
HP CR Admins group.

2-4 Installing Microsoft SQL Express on the HP CR 
server

The HP CR server utilizes the Microsoft® SQL Express database to store and archive messages. It 
requires access to one of the following SQL database applications: SQL Express 2016, 2012, or 2008.

Use one of the following SQL database applications:

 SQL Express 2016/2012/2008 - This limited Microsoft SQL database application provides the basic 
database services the HP CR server needs to maintain its SQL databases.

 SQL Express must be installed local to the HP CR server.

 SQL Express installation requires Microsoft .NET Framework 4.0

When installed on the HP CR server, the SQL server must only service databases for HP CR. 
Consider that installing a SQL server instance on the HP CR server might require the purchase of an 
additional SQL server license.

IMPORTANT:  Installing the full SQL Server (2016/2012/2008) on the HP CR server is not recommended.

NOTE:  If undetected during the automated prerequisites check, a minimum version of Microsoft SQL 
Express 2012 is automatically installed.
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3 Installing the HP CR server

The HP CR server is installed with:

 Specialized Windows services that carry out the document distribution responsibilities of the server.

 Components that complete message processing tasks.

 Connectors that connect the HP CR server with external systems that submit messages to the 
server and distribute them to their final destinations.

 HP CR Server Administrator, which is the management application for the HP CR server.

The remainder of this section describes:

Automated pre- and post-installation and configuration tasks (11)

Installing the HP CR server (12)

Creating and configuring the database (18)

Completing the server configuration wizard (21)

3-1 Automated pre- and post-installation and 
configuration tasks

The pre-installation package automatically verifies, installs, and/or configures a variety of prerequisites, 
including:

 Minimum versions of the OS, Internet Explorer, MS.Net, and Microsoft SQL

NOTE:  Internet access is required for the system to install Microsoft.Net v3.5.1.

Note also that in a Windows 2012 environment, MS.Net 3.5.1 is not included or configured with the pre-
installation pack. As a requirement for Device Client installations, you need to independently download and 
install MS.Net 3.5.1 to your Windows 2012 system.

 SMTP and IIS services

 32-bit IIS applications

 DCOM and IIS configuration

 Installation of required runtime libraries

 Application of Windows firewall settings 

 Print spooler service set to automatic

 User Access Control (UAC) set to required setting

Post-installation configuration requirements are automated as well. Post-installation configurations for the 
server include:

 Setting the Doc, Docx, XLS, XLSX, PPT, PPTX, HTM, and HTML formats to use the Aspose 
compose engine



Installing the HP CR server

12

 Setting a Cleanup task in Maintenance for 30 days

NOTE:  It is recommended to run this program on all servers that will run HP CR or remote HP CR 
components.

3-2 Installing the HP CR server
The HP CR server setup program has a verification utility that checks the server for compliance with 
installation requirements. All installation requirements must be met before HP CR can be installed.

TIP:  Before you start installing the HP CR server, review and verify that you have met all Requirements (7).

NOTE:  If you are setting up an HP CR server cluster, review the HP Cluster Service setup instructions 
(see Section 15: Setting up an HP CR Server Cluster, 131) before beginning the HP CR server installation. 
If you are setting up HP CR with a Telco Connector, see Section 16: Installing and configuring a Dialogic 
modem driver (145) before beginning the HP CR server install.

To install the HP CR server:

1. Log in to the system where you are installing the HP CR server using the HP CR service account. 

2. Go to a network copy of the HP CR server and open:

\HPCR\setup.exe

3. The HP Capture and Route Prerequisite Install Check screen opens. 

Select the option for which you want your system automatically prepared. 

Each option checks for and (if not already present) installs and/or configures the necessary 
prerequisites for your selection.

Complete Server – prepares the system to install the HP CR Server onto one host server, including:
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 Microsoft.NET Framework 4.6.1

 Microsoft.NET Framework 3.5 SP1

 Microsoft SQL Server 2012 Express

 Web Server IIS installation

 Sets the W3SVC Service (from the Web Server) to Automatic Startup

 Microsoft.NET Core 1.0.0 - Windows Server Hosting

 SMTP Service installation

 Sets the SMTP Service to Automatic Startup

 Adds a DCOM Exception in the Windows Firewall

 Sets the Print Spooler Service to Automatic Startup

Web Components – prepares the system to install the Web, Mobile and/or Device Client(s) to a 
remote host server, including:

 Microsoft.NET Framework 4.6.1

 Microsoft.NET Framework 3.5 SP1

 Web Server IIS installation

 Sets the W3SVC Service (from the Web Server) to Automatic Startup

 Adds a DCOM Exception in the Windows Firewall

Remote Components – prepares the system to install remote processing components onto a 
remote host server, including:

 Microsoft.NET Framework 4.6.1

 SMTP Service installation

 Sets the SMTP Service to Automatic Startup

 Adds a DCOM Exception in the Windows Firewall

 Sets the Print Spooler Service to Automatic Startup

Remote Modem Server – prepares the system to install remote modem components to a remote 
host server, including:

 Microsoft.NET Framework 4.6.1

 Adds a DCOM Exception in the Windows Firewall
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4. When the system finishes configuring your prerequisites, a Successful summary screen displays, 
listing components and their status. 

Click the installation type with which you want to proceed (HP Capture and Route Install or Web 
Apps Install). 

The system prepares the Installshield wizard for the installation process.

5. The InstallShield wizard resumes. Click Next. 
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6. The License Agreement page appears. Scroll down through the End-User License Agreement and 
select I accept the terms of the license agreement. Click Next.

7. Installation options appear in the Setup Type screen.

NOTE:  The default destination folder is: C:\Program Files(x86)\HP\HPCR 
You can change the destination if necessary by clicking Browse and then selecting the desired location.

Select one of the following: 

 Typical for an installation that does not support faxing from a Telco connector.

 Custom to select options, such as the modem server.
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If you selected Custom, select options for the HP CR server installation. The following features 
are selected by default:

 Message Server

 Connector Package

 Component Package

 Server Administrator

 Intelligent Device Client

  Client Installs

  Server Tools

  Mobile Device API

The following features must be selected for a server installation:

 Message Server

 Connector Package

 Component Package

 Server Administrator

 Client Installs

The remaining features can be installed on remote systems depending on the planned 
environment structure.

IMPORTANT:  Select the Modem Server option to support faxing with a local modem server. 

8. Review the results and perform one of the following listed actions. 

IMPORTANT:  If Microsoft Office is partially detected by the setup, exit the setup and verify that Office is 
configured for first-time use. Start an Office application and, if prompted, enter a user name and initials. 
Wait for a new document to open and then exit the Office application. If Microsoft Office is still only partially 
detected, verify that Word, Excel, and PowerPoint are installed and continue with the HP CR server 
installation.

 To exit the setup or to install components that are required for the installation, click Cancel 
and then click Yes to exit the setup.

 To continue with the installation, click Next. 
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9. The Prerequisites screen displays as the installer compares your configuration with the required 
setup components and lists the results. Click Next.

10. In the Service Account screen, the setup requests logon credentials for the HP CR service 
account. By default, the User Name field is populated with the name of the user logged into 
Windows. 

Provide the HP CR service account logon credentials:

a For NT Domain, enter the Windows domain name.

b For User Name, enter the user name.

c For Password and Confirm Password, enter the user password. 

Click Next.

11. Review the installation settings on the Installation Settings screen. Click Next to proceed with the 
installation. 
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Progress details appear on the Setup Status screen.

12. The Installshield Wizard Complete screen displays. Click Finish.

The setup launches the database configuration wizard (described in the next section).

3-3 Creating and configuring the database
Continue the installation process by creating and configuring the database. 

1. The HP Capture and Route database configuration wizard Welcome screen opens.

2. For a typical server installation, select Single-server configuration.

NOTE:  For more information about Failover cluster configuration, refer to Setting up an HP CR Server 
Cluster (131).

NOTE:  For more information about Disaster recovery configuration, refer to Configuring Disaster 
Recovery.
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3. The Database screen opens. 

Select Create a new database and click Next.

NOTE:  Only select Use an existing database if you are upgrading an existing release of this product. 
See Appendix: Upgrading HP CR v1.4.0 to HP CR v1.5.0 for more information.

4. The Create New Database screen opens. 

To create the database:

a Enter the SQL Server name:

 If the setup detects Microsoft SQL Server Express 2008/2012/2016, verify that the 
SQL Server field is populated with the name of the server running the Microsoft SQL 
server database application and that \SQLExpress is appended to the server name.

 If the setup detects SQL Server 2008 SP2 or SQL Server 2012/2016, verify that the 
Server field is populated with the name of the server running the Microsoft SQL server 
database application.

NOTE:  The default value is the local server where the setup is running.

b Select the authentication method that the HP CR services use to access the database. Choose 
one of the following:

 Use Windows Integrated Authentication to use the HP CR service account. This is the 
default choice. 
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 Use SQL Authentication Login to use SQL server authentication. If you select this 
option, enter the login credentials in the Username and Password fields.

c In the Database Name field, review the database name and modify it if necessary.

NOTE:  Special instructions apply to an HP CR server cluster. For the first server being set up, enter the 
database server name. For the second server being set up, allow the setup to create a local database. (The 
second server is configured to use the database server, so the local database is not used.) For more 
information, refer to Section 15: Setting up an HP CR Server Cluster (131).

d Click Next.

5. The File Share screen appears. 

Enter the File Share Location at which you want the system to store message documents and 
details, and click Next.

6. The Ready to Configure screen opens. Click Next to configure the new database. 

7. You can view progress of the configuration on the Configuring... screen. 

Click Next when the process is complete to launch the Server Configuration wizard (described in the 
next section). 
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3-4 Completing the server configuration wizard
After the HP CR server and database are installed, the Server Configuration wizard automatically 
launches. You must complete the Server Configuration wizard before starting the HP CR Server 
Administrator.

1. When the Server Configuration wizard opens to the Welcome screen, click Next. 

IMPORTANT:  When setting up the passive server in an HP CR server cluster, exit the server configuration 
wizard and click No when prompted to run the wizard again when HP CR Server Administrator starts. See 
Section 15: Setting up an HP CR Server Cluster (131) for additional information.

2. The Congratulations! screen appears to indicate the server configuration is complete. 

Click Finish to close the wizard. 
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The Server Configuration wizard saves the configuration and starts the HP CR Server Administrator.

When you close the HP CR Server Administrator, Microsoft Management Console displays a message 
about saving changes to the MSC file. This file records the current position of items in the console tree. To 
preserve the console state, save the changes.

If prompted to update the MSC file, click Yes.
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4 HP CR Server Administrator overview and 
post-installation configuration

The HP CR Server Administrator lets you manage your company’s HP Capture and Route (HP CR) 
servers, including connectors, components, devices, user permissions, and more.

You can use the Server Administrator to work with routing rules and see exactly what is happening to any 
message on the server either in process or in history. You can manage custom properties, folders, 
distribution collections, web client views, and Group permissions from the Server Administrator’s 
Configuration Node. 

To launch the HP CR Server Administrator:

Click Start > All Programs > HP Capture and Route > HP Capture & Route Server 
Administrator.

The HP CR Server Administrator is installed as part of the default server installation. You can also install 
the Administrator on a remote system (a Remote Administrator), which is useful if you want to manage 
your servers from a remote location. For more information on the Remote Administrator installation 
process, see Section 5: Installing a Remote Administrator.

This section provides overviews and post-installation configuration steps for the following topics:

Server license activation (23)

Messages (25)

Connectors (27)

Components (29)

RuleSets and rules (30)

Devices (31)

Configuration Node options (31)

The HP CR Intelligent Device Client (46)

For further details related to these topics, see the HP CR administrator online help.

4-1 Server license activation
After installation, the server uses a 60-day demonstration license. At some point during this time, the server 
license should be activated. This can be done automatically, or through a manual method, depending on 
whether the HP CR server has access to the internet.

4-1-1 Automatic license activation
Have available a copy of the Activation Code received with the software package.

1. Launch HP CR Server Administrator and expand the tree view.

2. Select the server name. Right-click and select Licensing...

3. Click the Activate License... button.

4. Select the Automatically activate via the Internet option.

http://www.omtool.com/documentation/hpcr/1.4.0/admin/index.htm
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5. Paste the Activation Code in the Activation Code page.

6. Click OK. The server is updated with the new license.

7. Click Close to complete the procedure.

4-1-2 Manual license activation
Have available a copy of the Activation Code received with the software package.

1. Launch HP CR Server Administrator and expand the tree view.

2. Select the server name. Right-click and select Licensing...

3. Click the Activate License... button.

4. Select the Export activation file for manual activation option.

5. Browse to a location to save the file.

6. From a system with internet access, launch the web browser and go to:

https://license.omtool.com/manual

The Manual License Portal page opens.

7. Paste the Activation Code in the Activation Code page.

8. Browse to the ManualActivation.exp file created in Step 5. Click Upload, then click NEXT.

9. Click Download and save the ManaulActivation.imp file to a location available on the HP CR 
server.

10. From the HP CR Server Administrator, select the server name. Then, right-click and select 
Licensing...

11. Select the Activate License... button.

12. Select the Import activation file from manual activation option.

13. Browse to the saved ManaulActivation.imp file.

14. Click OK. The license has been updated.

15. Click Close to complete the procedure.
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4-2 Messages
Messages can be inbound or outbound. You can configure special Routing RuleSets and rules for both on 
the HP CR server. These rules determine how messages are processed and where they are delivered. 

The Messages folder in the console tree lists all inbound and outbound messages on the HP CR server. 
The Messages folder includes two sub-folders:

 In Process - Lists messages that were submitted to the HP CR server and are being processed for 
delivery to the intended recipients. You can view properties of messages listed in this folder. You can 
also cancel messages intended for delivery.

 History - Lists messages the server finished processing. Some messages are delivered to the 
recipients while some may fail delivery. You can view the properties of messages listed in this folder. 
You can also resend or delete messages.

4-2-1 Specifying the originator of notification messages
The HP CR server generates notification messages for various events and sends them to users through 
the HP CR connectors for SMTP. The display name and email address (originator) associated with these 
notification messages can be set in the HP CR Server Properties. It is recommended that you set the 
attributes to a valid email address so users can reply to notification messages if they require assistance. 
(The default display name is Message Server and the default email address is MessageServer.)

To specify the originator of notification messages generated by the HP CR server:

1. Launch HP CR Server Administrator and expand the tree view.

2. Right-click the HP CR server in the console tree and select Properties. The Server Properties 
page opens.

3. Click Settings.

4. In the Email Address text box, enter the email address you want to associate with notification 
messages generated by the HP CR server. 



HP CR Server Administrator overview and post-installation configuration

26

5. In the Display Name text box, enter the name you want to associate with notification messages 
generated by the HP CR server.

6. Click OK to save changes to the Server Properties.
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4-3 Connectors
Connectors are the means by which messages enter and leave the HP CR server. With a connector, HP 
CR can communicate with external messaging systems. Depending on the system, it can either accept, 
deliver, or accept and deliver a message. 

All connectors are managed by a Windows server service called the Connector Manager, which engages 
connectors as needed and transfers messages between the other systems and the HP CR server. The HP 
CR server can deliver documents to many recipient types, including network folders, email, fax, printers, 
and more, through its connector subsystem.

HP CR can also capture and store a document and any related metadata that has been captured from the 
users or extracted from the document as part of its processing. Documents and metadata can be stored in 
SQL databases or saved in XML format and stored on network folders. Database or XML output from HP 
CR is one method to support integration with most archive, content management, workflow, or other 
information systems. This integration allows HP CR to serve as the platform for all distributed document 
capture and routing requirements.

The Connector Manager for HP CR is also the means by which new information systems and extensions 
are made available as upgrade options.

For more details on specific connectors, refer to the HP CR administrator online help. The following table 
briefly describes the connectors that are automatically included in the HP CR server environment:

Table 1 Connectors

Connector
Type

Connector 
Sub-Type Description Additional 

Requirements

Database Allows the HP CR server to route inbound messages 
(documents and faxes) to a SQL database. Extends 
the usefulness of archiving by allowing for specific 
routing rules.

SQL database

DMS Allows the HP CR server to route messages to a 
document management system (DMS).

HP Records 
Manager

Provides the ability to profile all of your important 
documents and store them in Records Manager. 
Users can route both soft copy and hard copy 
documents to Records Manager quickly and easily, 
using Records Manager's familiar, native windows.

HP Records 
Manager

iManage (DMS) Allows users to send both soft copy and hard copy 
documents to iManage quickly and easily.

FileShare (DMS) Allows the HP CR server to route messages to a 
specified network folder (the FileShare folder). 
Supports outbound messages.

Shared network 
folder

SharePoint (DMS) Provides tight integration with Microsoft SharePoint 
through SharePoint's native interfaces.

MS SharePoint 
FileShare

Universal Output 
(DMS)

Picks up and processes the XML documents and 
submits them to the route server for delivery to the 
intended recipients.

Shared network 
folder

http://www.omtool.com/documentation/hpcr/1.4.0/admin/index.htm
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Fax Allows the HP CR server to send and receive faxes.

HP LAN Fax Allows the HP CR server to send outbound fax 
messages from an HP device to the HP CR server 
for outbound fax delivery.

Shared network 
folder

T.37 Fax Uses Simple Mail Transport Protocol (SMTP) to 
generate fax messages conforming to the T.37 
protocol. Allows you to send outbound fax messages 
as an email to another fax server or fax service 
provider that accepts T.37 SMTP messages.

SMTP services 
installed

Telco Allows the HP CR server to send and receive faxes. 
The Telco connector works in conjunction with the 
modem server software that is installed in the HP CR 
server. Supports outbound messages only.

Modem drivers 
installed

Bursting Allows you to split up (or burst) document batches. It 
uses barcodes to identify and break up documents

Data Extractor 
License

Filescan Allows the HP CR server to route messages to and 
from a specified network folder (the Filescan folder). 
Acts as an "on ramp" or "off ramp" to the system. 
Supports both inbound and outbound messages.

Shared network 
folder

HP CR Server Allows the HP CR server to manage communication 
between the server and its connectors. Supports 
both inbound and outbound messages.

All servers require the server connector.

Printer Allows the HP CR server to route documents and 
faxes to printers in the local area network.

Printer drivers 
installed

SMTP Allows the HP CR server to communicate with an 
SMTP mail server. Supports both inbound and 
outbound messages.

SMTP services 
installed

Universal Input Picks up and processes XML documents and 
submits them to the HP CR server for delivery to the 
intended recipients. The Universal Input connector 
enables HP CR to support integration with HP 
iManage TeleForm.

Connector
Type

Connector 
Sub-Type Description Additional 

Requirements
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4-4 Components
Integral to the HP CR Server, components are the engines that process messages within the system. A 
component is a part of the HP CR Server that performs a specific task. For example, the Dispatch 
component determines the appropriate delivery method for every inbound and outbound message on the 
HP CR Server.

Other components perform functions such as composing a message into a format appropriate for the 
method of delivery, modifying a fax number, or determining whether a message requires previewing before 
processing.

 All components are managed by a Windows service called the Component Manager that manages the 
flow of messages through the components and processing steps of a message. Except for the Compose 
component, you do not need a special license to run these components.

NOTE:  Depending on the HP CR Server application you are running, the HP CR Server might only use 
some of the components in the environment. However, you cannot delete components from the HP CR 
Server.

For more details on specific components, see the HP CR administrator online help. The following table 
briefly describes the components that are automatically installed with the HP CR server:

Table 2 Components

Component Description

Billing Extracts data from messages and populates a table in the Archive database with 
this information.

Compose Converts messages and documents into an appropriate format for delivery. The 
Compose component handles the conversion of all files. It is also responsible for 
compression and variable substitution for notifications and routing sheets.

The Compose component is the "work horse" of the server and as such, offers 
great flexibility and scalability. In large environments, additional Compose 
licenses may be required.

Data Extractor Allows for the extraction and mapping of barcode data from documents that pass 
through the HP CR Server. The Data Extractor allows the HP CR Server to read 
and process barcoded cover sheets (or separator pages) generated by third party 
systems.

Dispatch Determines the appropriate delivery method for all messages–inbound and 
outbound.

Embedded Directive Manager Detects, decodes, and applies Embedded Directives.

Lookup Manager Looks up a DID number and finds the appropriate recipient for an inbound fax.

Maintenance and Archive Performs archiving and cleanup functions on the HP CR Server.

Notification Generates and sends notification messages from the HP CR Server to the email 
accounts of message senders and recipients when important events occur during 
the processing of a message.

Preview Manager Determines whether or not a message needs to be previewed before the HP CR 
Server continues processing it for delivery.

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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4-5 RuleSets and rules
A routing Rule functions as a dispatch, telling a message which path to follow. It acts as an "if then" 
statement, matching criteria with an action (such as splitting attachments, merging attachments, converting 
one file format to another, sending to different connectors, and more).

RuleSets are collections of related rules. Some RuleSets (User, Received Faxes, and Default RuleSets) 
are automatically created when you install the HP CR server. You can also create your own (Custom) 
RuleSets for collections of custom rules. The rules can be inbound or outbound and the system processes 
them according to how they are arranged on the screen. 

RuleSets offer administrators more opportunities to customize and interact with their system’s workflow. 
For example, you can configure non-linear processing by defining the order in which rules are applied. (You 
can easily move rules within a RuleSet up and down the list.) You can also configure criteria to be met in 
order to send or disable user notifications.

4-5-1 How rules work after installation
When a message arrives on the HP CR server via a connector, the server tries to match the message 
against existing rules to determine how it should be processed. When a message matches a rule, the HP 
CR server begins processing the message according to the actions associated with that rule. 

Routing rules can be Received Faxes, User, Default or custom-created:

 Received Faxes - The Received Faxes RuleSet contains all of the inbound fax routing rules. The 
HP CR server uses the Received Faxes rules when processing inbound fax messages. The rules 
are listed in the same order they are used in processing messages. 
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 Default and User - The Default and User RuleSets list all outbound rules defined for the HP CR 
server. The system uses them to process outbound messages. The rules are listed in the same 
order they are used in processing messages.

4-6 Devices
The Devices node enables you to manage devices and create groups of devices with customized buttons.

NOTE:  The HP CR Embedded Device Client must be installed before being added to the Devices node. 
To learn more about this device client, see Section 9: HP CR Device Clients for HP OXPd.

There are two main methods of pushing the HP CR buttons to the device:

 Using the Device node in the HP CR Server Administrator

 Using WebJet Admin

The HP CR Server Administrator Device node is a simple method for pushing out a small number of 
devices. In larger organizations, it may not be practical to push out one device at a time and, therefore, the 
WebJet Admin should be used.

For more information on managing devices, see the HP CR Embedded Device Client Installation Guide 
and the HP CR administrator online help.

4-7 Configuration Node options
The Configuration node has options available to create and manage features specific to a company’s 
workflow, including the following features:

 Custom Options – Configure customized properties to, for example, enhance images, set message 
priorities, etc.

 Job Properties – Use properties to display prompts at the HP CR Client, at the device, or at both the 
HP CR Client and device.

http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm


HP CR Server Administrator overview and post-installation configuration

32

 Folders – Create and configure the routing of documents to Dropbox, OneDrive, FTP, WebDav and 
network folder share locations.

 Search Filters – Configure customized message searches using a wide assortment of message 
meta-data criteria. Search Filters are also available via the Messages node, to filter all messages, or 
for either the In Process Queue or Message History. Search Filters can be saved for later use.

 Document Stamps – Create and configure Document Stamps - like watermarks - to be applied to 
.PDF messages and distributions.

 Distribution Collections – Create and configure sets of distributions and associate them to user and 
device groups.

 Web User Interface – Assign Applications (such as Inbox, Create Distribution, etc.) to Web Apps 
Profiles, which in turn are associated to specific user groups, and define the Web Apps user display.

 Legacy Web User Interface – Define the features available for users of the Legacy Web View on the 
End User Interface, including access to the Help Desk, Archive Search, Deficiencies, and approval.

 Groups – Configure user permissions to prompts, scan settings, printers, the Mobile Client, and 
more.

Find further Configuration node details in the HP CR administrator online help.

4-7-1 Custom Options
Custom Options are customized properties created by the HP CR Server Administrator for use by HP CR 
users.

The Administrator can, for example, configure image cleanup properties for the HP CR Server, thereby 
reducing white noise when scanning documents. Some examples of Custom Options are image 
enhancement, set message priority to high, set message priority to low, etc.

NOTE:  Custom Options must first be added as a Property Dictionary Item in the Properties node. See 
the ‘Creating a message property’ topic in the HP CR administrator online help.

For more information, see the Custom Options topics in the HP CR administrator online help.

4-7-2 Job Properties
You can create properties for almost any type of template tag. You can use these properties to display 
prompts at the HP CR Client, the Mobile Client, the device, or all three.

System properties are created when the HP CR Server is installed. You can create additional custom 
properties in the User Node or create a completely new node under Job Properties to support any custom 
meta data needed in a workflow.

You can create job properties or metadata fields, as needed. For more information on Job Properties, 
Regular Expressions, and Validators, see the ‘Job Properties’ topics in the HP CR administrator online 
help.

4-7-3 Folders
The Folders feature supports routing documents to Dropbox™, Microsoft® OneDrive™ (Personal or 
Business), Google Drive™, box, FTP, WebDav and network folder share locations. Folders can be 
configured in the HP CR Server Administrator to allow users to navigate, or navigate and create, sub-
folders. Users can access the configured Folders from the HP CR Device Client, the HP CR End User 
Interface, or the Mobile Client, where they can create a distribution containing any Folders defined for their 
domain group as a recipient destination.

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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Folder configuration includes:

Requirements for using Folders (33)

Creating a Folder for cloud-based storage folders (33)

Creating a Folder for FTP (34)

Creating a Folder for Network Folder Shares (36)

Configuring groups to access Folders (37)

Configuring the MFP to capture user credentials (38)

NOTE:  For information about FTP and FTPS support and configuration, see the ‘FTPS Support’ topics in 
the HP CR administrator online help.

4-7-3-1 Requirements for using Folders

The following options are available when creating a Folder:

 Network Folder Shares

  Dropbox

 Microsoft OneDrive (Personal or Business)

 Google Drive

 box

 WebDav

 FTP

When using Folders, be sure the following requirements are met:

 Before you create and configure Network Folder Share (NFS) Folders, verify that UNC share 
destinations (for example, \\servername\share) are remote, not local. Otherwise, your share 
destination can be local if specified by a direct path (for example, C:\fileshare).

 Before you create and configure File Transfer Protocol (FTP) Folders, FTP services must be 
accessible to the HP CR server.

 For users to access configured Folders, the Groups Folder tab must be enabled for the applicable 
Folders.

 To configure the MFP to Capture User Credentials, the Device Client Group node must already be 
configured before you proceed.

 The HP CR server must have a live connection to the internet. (for Dropbox, MS OneDrive, Google 
Drive, and box)

NOTE:  The software may enable you to send data to third parties in connection with use of their services, 
including box, Google (Google Drive), or Microsoft (Microsoft OneDrive) .

4-7-3-2 Creating a Folder for cloud-based storage folders

1. Launch the HP Server Administrator, expand the Configuration node, and select the Folders node.

2. Right-click Folders and select, for example, New > Dropbox. The Folder Properties screen 
appears.

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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3. In the General tab, enter a folder name in the Name text box.

4. Select the Allow users to navigate sub-folders checkbox, as needed.

If you select the first box, the Allow users to create subfolders checkbox becomes active. Select 
this box, if appropriate.

5. A default Folder Key value appears. It is recommended that you change the Folder Key value to 
one specific to the planned destination. For example, a Folder Key of SalesExpenseShare would 
be logical to assign to a folder of the same name.

6. Click OK. The new folder appears in the Folders node.

4-7-3-3 Creating a Folder for FTP

1. Launch the HP Server Administrator, expand the Configuration node, and select the Folders node.

2. Right-click Folders and select New > FTP. The Folder Properties screen appears.

3. In the General tab, enter a Folder name in the Name text box.

4. Select Allow users to navigate to sub-folders, as needed.

If you select the first box, the Allow users to create sub-folders checkbox becomes active. Also 
select this box if appropriate.

5. A default Folder Key value appears. It is recommended that you change the Folder Key value to 
one specific to the planned destination. For example, a Folder Key of SalesExpenseShare would 
be logical to assign to a folder of the same name.
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6. In the Settings tab, configure the connection settings as follows:

 FTP Address: Enter the connection string for the FTP server.

The FTP address can be either the machine name or the IP address of the machine.

When entering the address, you can point it either to the root of the FTP or to a subfolder if 
one exists. Examples are:

ftp://123.45.67.89

ftp://123.45.67.89/Sales

 Credentials: Enter the Administrator account with permissions to write to the FTP server 
folders.

 Select Use user supplied credentials if available, as needed.

 Select the appropriate option for FTP Settings:

 Unsecured Connection

 Explicit TLS

 Explicit SSL

 Implicit TLS or SSL

 Check either Passive Transfer or Allow connections to servers with improper 
certificates, as appropriate. Click OK to complete the FTP folder information.

7. Click OK. The new Folder appears in the Folders node.

NOTE:  For more details about FTP and FTPS support and configuration, see the HP CR administrator 
online help.

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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4-7-3-4 Creating a Folder for Network Folder Shares

1. Launch the HP Server Administrator, expand the Configuration node, and select the Folders node.

2. Right-click Folders and select New > Network Folder Shares. The Folder Properties screen 
displays.

3. In the General tab, enter a folder name in the Name text box.

4. Select Allow users to navigate to sub-folders, as needed.

If you select the first box, the Allow users to create sub-folders checkbox becomes active. Also 
select this box, if appropriate.

5. A default Folder Key value appears. It is recommended that you change the Folder Key value to 
one specific to the planned destination. For example, a Folder Key of SalesExpenseShare would 
be logical to assign to a folder of the same name.

6. In the Settings tab, enter the Path to the network folder share of interest. For example:

\\<server_ip_address>\HP\HPCR\shared
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NOTE:  The server IP address or the computer name can be used in the UNC path.

7. In the Connect using section, select either:

Service Account - The service account that starts the HP CR services will need permissions to 
the folder. When a document is stored in this folder, the service account is the user responsible 
for storing it.

Specific Account - Enter a user name and password. Regardless of who was authenticated at 
the device, this specific user will store the document in the folder and requires permissions at 
the operating system level.

8. If you want to require MFP users to sign in, select the Use user supplied credentials if available 
checkbox, and click OK. Otherwise, just click OK. 

When a user logs on to a device as an authenticated user, the system uses the credentials provided 
when it passes the document through to be stored in a folder.

NOTE:  If you select the Use user supplied credentials option, then you must also enable the capture 
user credentials option for the Folder button in the Device Group.

The new Folder displays in the Folders node.

4-7-3-5 Configuring groups to access Folders

1. Launch the HP CR Server Administrator, expand Configuration > Groups.

2. Right-click the group of interest and select Properties. The Group screen opens.
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3. Select Folders In the Jobs section, and select Enable members of this group to select the 
specified Folders.

4. Select the Folders of interest from those configured. Click OK.

4-7-3-6 Configuring the MFP to capture user credentials

User credentials can be used to deliver files to specific folder locations. In order to apply these to a 
delivered document, the MFP must be set to capture the user's login credentials.

1. In the HP CR Server Administrator, expand Configuration > Devices.

2. Right-click the device of interest and select Properties.

3. In the Device Group Properties screen, click the Buttons tab.
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4. Select a button that will capture the user password (such as Folders), and click Properties.

5. In the General tab, select Require authentication and Capture user password.

6. If you want the device user to be prompted to login when using this button, select Always prompt 
user for password.
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7. Select the Options tab and enable the Folder functionality that is appropriate for your intended 
workflow, as follows:

 Display authenticated user's Group Folders – enable when the user must authenticate in 
order to be able to select the folders assigned to their user group.

 Display the following Folders – enable and select the folders from the list that you want to be 
available. This setting does not require the user to authenticate.

 Enable both options to create unique folder options for users, based on login permissions 
and default button folders.

NOTE:  Dropbox folder options require authentication in order to access the users personal Dropbox folder.

8. Click OK and click OK again.

NOTE:  Permission (at the share level) for capture and use of user credentials requires that the user 
account specified or the group the user belongs to has read/write privileges.

4-7-4 Search Filters
You can create customized Search Filters using a wide assortment of message meta-data criteria. You can 
create Search Filters on the fly for immediate use and save customized searches for future use. The 
Search Filter feature is also available via the Messages node, from which you can filter all messages, or 
specifically filter either the In Process or History Queues.

4-7-5 Document Stamps
Document Stamps are like watermarks for your .PDF attachments. Document Stamps are applied by the 
system during the delivery process, rather than during composition. You cannot view a document stamp 
on an attachment before sending the document.
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NOTE:  Document Stamps are only for .PDF documents. If a message includes mixed formats, the stamp 
only applies to the .PDF files included.

Document Stamps can be used in three ways. You can:

 Provide permission for individual user groups to apply them. You may want particular groups to have 
access to specific stamps.

 Configure Document Stamps for rule-based application. To do so, you identify the specific Document 
Stamp as an advanced custom core property when creating the rule.

 Configure Document Stamps to be applied when submitting documents from the FileScan 
connector. To do so, use the  #prDocumentStampName control file variable with the 
DocumentStampName as the value.

TIP:  HP CR End User Interface and Mobile Client users can apply available Document Stamps per recipient in the 
General tab of the Options screen.

For more information on creating and configuring Document Stamps, see the ‘Document Stamps’ topics in 
the HP CR administrator online help.

4-7-6 Distribution Collections
You can create Distribution Collections and associate user-created distributions to these Distribution 
Collections. You can then associate Distribution Collections with the Public Distributions button of specific 
device groups (via the device group properties). Distribution Collections can also be associated to 
individual user groups, allowing multiple groups to access specific Distribution Collections.

NOTE:  Distribution Collections can be assigned to the Public Distribution button for default access by 
non-authenticated users. Authenticated users can have access to the Distribution Collections associated 
with the Public Distribution button, as well as the Distribution Collections associated with their user group.

For more information on creating and configuring Distribution Collections, see the Distribution Collections 
topics in the HP CR administrator on-line help.

4-7-7 Web User Interface
Web User Interface is the highly-customizable HP CR End User Interface. In the Web Apps node, you 
can assign specific Applications (such as Inbox, Create Distribution, etc.) and Features (such as 
PrinttoWeb) to Web Apps Profiles. You can tailor Profiles for different user groups in your organization. 
Then, you associate the profiles to the specific user groups, defining what individual Web Apps users will 
see.

The Web Apps node offers the following applications:

 Messages – Inbox, Outbox, Preview, and SentItems

 Distributions – Collections, MobileReservations, My, and Subscribed

 Settings – Assistants, CreateBookmarkPage, CreateMyFilesDistribution, Delegates, Folder 
Authorizations, Options, and SubscribedDistributions

 CreateDistribution

 DirectSend

 MyFiles

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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 Nested

Web Apps also supports the DocumentLink, Favorites, PrinttoWeb, ScantoWeb, and SendtoWeb 
Features.

4-7-8 Legacy Web User Interface
In the Legacy Web Views node, the System Administrator can setup different Legacy Web Client View 
features and then assign the appropriate view (depending on the enabled features) to specific user groups.

Legacy Web Client Views supports the following features:

 setting a Default Routing Sheet template

 enabling the Address Book lookup function

 assigning Fax cover pages

 setting the availability of the following folders to HP CR End User Interface users: Messages, 
Distributions, My Files, Administration, and Online Help.

NOTE:  Access to the Administration folder enables the Help Desk management feature. The Help Desk 
users can oversee and manage Messages and Distributions, which includes the ability to search, view, 
cancel, resend, and access attached files from the HP CR server.

Also note, the Legacy Web Views Node is the only location to configure access to the Help Desk, Archive 
Search, Deficiencies, and approval. These features are currently unavailable for Web Apps.

For more information on defining and configuring the Web Client Views node, refer to the HP CR 
administrator online help.

4-7-8-1 Enabling a Legacy Web Client View

You can specify the Legacy Web Client view (default or admin) to be used by members of a group.

1. Launch HP CR Server Administrator, expand the tree view, and click Configuration > Groups.

2. In the right pane, double-click on the Default group (or applicable group). The Group page opens.

3. Click Web in the Clients section.

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm


43

HP CR Server Administrator overview and post-installation configuration

4. Select Enable members of this group to use the following web view.

5. Then select the appropriate .xml for the Legacy Web Client view.

6. Click OK to close the Group page.

4-7-9 Groups
You can assign user permissions in groups. You can configure client options, specific features, and jobs 
for each group. The server functions that use group access permissions are found in the Group screen.

The General functions include:

 General - stores the name and description of the group

 Clients

 Access 

 Members - lists the Active Directory members that make up the group
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 Clients - identifies members of the group as users and determines their routing options, 
access to Distribution Rules, user view configuration, and more

 Mobile - determines whether members of the group have permission to use the Mobile Client 
and the Quick-Use distribution collections

 Web Client - determines group permissions to use the HP CR End User Interface client (with 
or without the administrative view)

 Features

 Custom Options - determines what configured Custom Options members of the group can 
use

 Distribution Collections - indicates which Distribution Collections members of the group 
have permission to use

 Document Stamps - determines availability of specific Document Stamps to the group

 Fax Cover Pages – lists cover pages available for use

 Prompts - determines what pre-configured prompts members of the group can use

 Scan Settings - determines whether members of the group can use and configure Scan 
Settings for a particular device or device group

 Jobs

 Apply Properties - lists Properties associated with the job

 Destinations - determines availability of specific destinations to members of the group

 Folders - indicates configured Folders that are available as a destination for members of the 
group

 Printers - indicates configured printers that are available as a destination for members of the 
group

4-7-10 Adding and configuring network printers for groups

4-7-10-1 Adding network printers

The HP CR End User Interface will read the list of configured network printers on the HP CR server. Before 
the network printers are listed in the HP CR End User Interface, the network printers must be added to the 
Printers tab in the Groups section of the HP CR Server Administrator, as described below.

1. Install the printer driver on the HP CR server using the standard Windows installation procedure.

2. Launch HP CR Server Administrator, expand the tree view, and click Configuration > Groups.

3. In the right pane, double-click the Default group (or applicable group). The Group page displays.

4. Click Printers in the Jobs section.
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5. Select Enable members of this group to select the specified Printers and click the Add button.

6. The Add Printer page is displayed.

7. Enter the printer information. For example:

8. Click OK. Click OK again to save the changes. See the Selecting a network printer section of this 
guide.

4-7-10-2 Modifying network printer properties

1. Launch HP CR Server Administrator, expand the tree view, and click Configuration > Groups.

2. In the right pane, double-click the Default (or applicable) group.

3. Click the Printers tab.

4. Highlight the printer that needs to be modified and click Properties.

5. On the Edit Printer page, make all needed changes and click OK.

6. Click OK again to close the Group page.

4-7-10-3 Removing a network printer

1. Launch HP CR Server Administrator, expand the tree view, and click Configuration > Groups.

2. In the right pane, double-click the Default (or applicable) group.

3. Click on the Printers tab.

4. Highlight the printer to modify, and click Remove.
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5. Click OK to close the Group page.

4-8 The HP CR Intelligent Device Client
The HP CR Intelligent Device Client is a request handler for client applications. It is comprised of a group 
of IIS web server extensions providing a layer for communication between clients and the HP CR server. 
For example, it allows a client (such as Embedded Device Client for HP OXPd v1.7.2) to submit messages 
to the HP CR server. It also allows the clients to pull up information about embedded directives from the 
server.

Figure 4-1 The HP CR Intelligent Device Client environment

Intelligent Device Client facilitates 
communication between the HP CR server 
and other HP CR applications.

IMPORTANT:  HP CR installs the HP CR Intelligent Device client by default. No separate installation is 
necessary. You must configure the client and test it, as described below.

If necessary, you can install the client on a remote system. For instructions, see Section 8: Installing the 
Remote HP CR Intelligent Device Client (69).

Refer also to HP CR Intelligent Device Client components and Optional configuration: Modifying the 
directory security configuration of virtual directories. For information about IIS implementation (Windows 
2003 64-bit only), refer to the HP CR administrator online help.

4-8-1 HP CR Intelligent Device Client components
The Intelligent Device Client is the bridge that delivers information from the HP OXPd device to the HP CR 
server. The HP CR Intelligent Device Client manages the Embedded Device Client for HP OXPd v1.4 and 
v1.6 separately. Each category utilizes a unique web server extension, application pool, virtual directory, 
and location. 

The main components of the Intelligent Device Client environment are detailed in the following table.

Table 3 Description of Intelligent Device Client components with location and function

Component Location Function

WebAPI C:\Program Files (x86)
\HP\HPCR\WebAPI\WebAPI

This folder is utilized for Embedded HP CR intelligent 
devices. Applications like Embedded Device Client for HP 
OXPd submit messages to: 
...\HP\HPCR\WebAPI\WebAP\FilePostings.

The messages are processed by OmISAPIU.DLL, other 
supporting DLL files, and XML-based configuration files in: 
...\HP\HPCR\WebAPI\WebAP\Scripts.

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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4-8-2 Optional configuration: Modifying the directory security 
configuration of virtual directories

The virtual directories created by the Intelligent Device Client setup grant authenticated access via 
integrated Windows authentication.

The default authentication and access control configuration can be modified if it does not comply with the 
security policy in the LAN. The Intelligent Device Client supports all IIS authentication methods except 
.NET Passport and Digest Authentication for Windows Domain server. It also supports IP address and 
domain name restrictions.

NOTE:  After the Intelligent Device Client is installed, the virtual directory properties are set to allow read 
access, allow execute permissions on scripts and executable, and use its associated application pool 
(WebAPI). Do not modify these settings.

Figure 4-2 Default Authentication and Access Control Configuration for a Virtual Directory

After the Intelligent Device Client is installed, the authentication and access 
control configuration for the virtual directory enables anonymous access 
with the local IUSR account or the account specified during installation and 
enables integrated Windows authentication.

A modified configuration must meet the following conditions:

 If anonymous access is enabled, the account used for anonymous access must have full control to 
read and write to the folder. These permissions are configured in the Windows security settings on 
the folder.

 If integrated Windows authentication is enabled, all accounts used to post and download files and 
gain access to the OmISAPIU.DLL resource, must have full control to read and write to the folder. 
These permissions are configured in the Windows security settings on the folder. For information on 
accounts that are used to post and download files and gain access to the OmISAPIU.DLL resource, 
consult the HP CR documentation on the application being used in conjunction with the Intelligent 
Device Client. (Refer to Online help and related documentation, 6.)
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4-8-3 Testing connectivity to the Intelligent Device Client
An Embedded Device Client for HP OXPd application must be able to access the Intelligent Device Client 
configuration file OmISAPIU.DLL. Test the connection to the web server and verify that the Intelligent 
Device Client is installed and configured correctly.

1. Log in to any system in the LAN that is running the HP CR server or client software.

2. Start the browser and go to:

http://[web server]/[virtual directory]/Scripts/
OmISAPIU.dll?Action=GetConfiguration

where [web server] represents the web server host name or IP address, and 
[virtual directory] represents the name of the virtual directory in IIS that is accessed by the 
Embedded Device Client for HP OXPd application.

TIP:  A connection to the Intelligent Device Client from a device running an Embedded HP OXPd device 
client application is similar to:
http://localhost/WebAPI/Scripts/OmISAPIU.dll?Action=GetConfiguration

When constructing the URL, consider the following:

 The Action command in the URL is case-sensitive.

 If Secure HTTP connectivity is configured for the End User Interface, replace HTTP with HTTPS.

The browser displays the basic configuration for the Intelligent Device Client.

If an error occurs, troubleshoot the web server and repeat the test until it is successful. See the HP CR 
administrator online help (“Connectivity issues with the HP CR Intelligent Device Client” topic).

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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5 Installing a Remote Administrator

HP CR Server Administrator is the management application for the HP CR server. When installed on a 
remote system, this server management application is called a Remote Administrator. 

The Remote Administrator provides convenient access to the HP CR server for administrators who support 
the implementation. It includes support for Windows 7, which allows administrators to manage the HP CR 
server from their personal workstations.

NOTE:  There is no known limit on the number of Remote Administrators the HP CR server can support.

Figure 5-1 HP CR server with HP CR Server Administrator and Remote Administrators

The HP CR server shown here has HP CR Server 
Administrator and three Remote Administrators 
installed. This is an example of a supported 
configuration. (The HP CR server must be installed with 
HP CR Server Administrator, but the environment can 
have more or fewer Remote Administrators than shown 
in this illustration.)

The remainder of this section describes:

Requirements for the Remote Administrator (51)

Installing the Remote Administrator (52)

Starting the HP CR Server Administrator and connecting to the HP CR server (54)

Problems connecting to the HP CR server using Remote Administrator (54)

For additional information (including optional configuration), refer to the HP CR administrator online help.

5-1 Requirements for the Remote Administrator
A Remote Administrator requires a system that meets the minimum Hardware and software requirements 
(7) and Additional installation requirements (8) listed for the HP CR server. In addition, a Remote 
Administrator requires:

 Windows NT domain computer that belongs to the same domain as the HP CR server

 Dual core processor, 2 GHz, 4GB of RAM, RAID 5W with 100 GB of disk space, and Microsoft 
mouse or compatible pointing device 

 Windows 2012 64-bit, Windows 2008 R2 64-bit, Windows 7

 Microsoft Internet Explorer 7 or later

 Acrobat Reader 7.0 or later

http://www.omtool.com/documentation/hpcr/1.5.0/serverhelp/index.htm
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 Access to a network copy of the HP CR server setup

 Windows user account running Remote Administrator that belongs to the HP CR Administrators 
group

5-2 Installing the Remote Administrator
1. Log in to the system where you will install the Remote Administrator using an account that belongs 

to the HP CR Administrators group.

2. Navigate to the network share where the HP CR server setup files are located.

3. Run:

\HP CR\setup.exe

The system runs the Prerequisite checks. When the Successful Summary appears, click Remote 
Components. The InstallShield wizard opens, configures your system for installation, and displays 
a welcome message.

4. Click Next. The setup shows the License Agreement page.

5. Select I accept the terms of the license agreement and click Next. The setup shows the 
installation options.

6. Select Custom and click Next. The setup shows a list of HP CR features.
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7. Select Server Administrator. Clear all the other features you are not installing.

8. Click Next. The setup checks the system for installation requirements and displays the results.

NOTE:  The setup cannot continue until all required components are installed. (Double-click an item in the 
list for more information.) If any required components were not detected, click Cancel and Yes to exit the 
setup and install the components that are required to complete the installation.

9. Click Next. The setup shows installation settings.

NOTE:  If other installation features are included, the setup might request additional information before 
displaying installation settings.

10. Review the installation settings and click Next to start the installation. The setup installs the selected 
features and displays a message indicating that the installation is complete.
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11. Click Finish.

After Remote Administrator is installed on the remote system, start HP CR Server Administrator and 
connect to the HP CR server, as described below.

5-3 Starting the HP CR Server Administrator and 
connecting to the HP CR server

1. Log in to the system where you installed the Remote Administrator using an account that belongs to 
the HP CR Server Administrators group. 

2. Click Start > All Programs > HP Capture and Route > HP Capture & Route Server 
Administrator to open the HP CR Server Administrator. 

The Specify Message Server page opens and the Network Address field is populated with the 
local system name.

3. Enter the HP CR server computer name or IP address and click Finish. The Microsoft Management 
Console starts and opens the HP CR Server Administrator snap-in. 

TIP:  When HP CR Server Administrator is closed, Microsoft Management Console displays a message 
about saving changes to the MSC file. This file records the current position of items in the console tree. To 
preserve the console state, save the changes. If prompted to update the MSC file, click Yes.

5-4 Problems connecting to the HP CR server 
using Remote Administrator

If you have trouble connecting to the HP CR server using the remote Administrator, add the DCOM port 
135 to the Exceptions list by keeping the Firewall ON. You should then be able to connect to and launch 
the HP CR server without any issues.
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HP CR Compose component (Composer) is a system that performs message conversion tasks for the HP 
CR server. A server supports multiple Composers, all managed by the Compose component on the HP CR 
server. A remote system that hosts a Composer is called a remote Composer.

Figure 6-1 HP CR server with a local Composer and remote Composers

The HP CR server shown here has a 
local Composer and three remote 
Composers. This is an example of a 
supported configuration. (The HP CR 
server can run without a local 
Composer, and the environment can 
have more or fewer remote Composers 
than shown in this illustration.)

When you install an HP CR server, the Compose component is installed as part of the Component 
Package and a Composer is created locally. As Composers are added, the Compose component workload 
is distributed automatically. Workload distribution can be manipulated by modifying the capabilities of each 
Composer. By default, a general Composer composes all types of messages, all enabled file types and 
final formats, and all template types. But, each Composer can be modified to accept only certain types of 
jobs. This filtering enables a Composer to become specialized for certain types of conversions. It is also 
possible to enforce policies that would cause messages with certain file types or templates to fail.

When scaling an environment with additional connectors or components, you should contact your software 
representative who can assist you in correctly identifying potential bottlenecks in the system based on 
workload and other factors. Your software representative can provide helpful information on the overall 
impact of increasing the system speed and efficiency.

The remainder of this section describes:

Requirements for a remote Composer (56)

Installing the remote Composer (57)

Adding the Composer to the HP CR server (59)

For additional information (including optional configuration), refer to the HP CR administrator online help.

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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6-1 Requirements for a remote Composer

6-1-1 Basic requirements
A remote Composer requires a system that meets the minimum Hardware and software requirements (7) 
and Additional installation requirements (8) listed for the HP CR server. In addition, a remote Composer 
requires:

 Windows NT domain computer that always runs in the same domain as the HP CR server

 Dual core processor, 2 GHz, 4GB of RAM, RAID 5W with 100 GB of disk space, and Microsoft 
mouse or compatible pointing device 

 Windows 2012 64-bit, Windows 2008 R2 64-bit

 Microsoft Internet Explorer 7 or later

 Access to a network copy of the HP CR server setup

 Windows user account that belongs to the HP CR Administrators group

 License key for each additional Composer 

NOTE:  A license key is not required if the local Composer is being moved to a remote system.

6-1-2 Software requirements for message conversion
A specific application is required only if the Composer needs to convert documents into file types 
associated with the application. For example, if you are planning to use Crystal Reports for compose, it 
must be installed on the Composer.

NOTE:  If Microsoft Office is not deployed in the LAN, the requirement does not apply.

 Microsoft Visio 2007/XP/2000 for *.VSD and *.VDX message attachments

 Crystal Reports v10.0 or earlier for *.RPT message attachments

 Microsoft Word 2007/XP/2000 for *.DOC Routing Sheet templates

NOTE:  Routing Sheet templates are provided in *.DOC and *.OMTPL format, and these templates can be 
edited in Word and WordPad, respectively. If *.DOC templates are used, Word is required because the 
Composer converts all *.DOC Routing Sheet templates using Word. The Composer cannot be configured 
to use any other conversion method.

 Microsoft Office 2007/XP/2000 for *.DOC, *.DOCX, *.XLS, *.XLSX, *.PPT, and *.PPTX message 
attachments (recommended)

If multiple versions of an application are deployed in the LAN, the most recent version must be installed on 
the Composer. For example, if Office 2010 and 2007 are deployed, then Office 2010 must be installed on 
the Composer.
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6-2 Installing the remote Composer

NOTE:  Before installing a remote Composer on a Windows 2008 system, allow DCOM port 135 as an 
exception. Otherwise you will not be able to add the remote Composer. 

1. Log in to the system where you will install the remote Composer using an account that belongs to 
the HP CR Administrators group.

2. Navigate to the network share where the HP CR server setup files are located.

3. Run:

\MessageServer\setup.exe

The InstallShield wizard opens, configures your system for installation, and displays a welcome 
message.

4. Click Next. The setup shows the License Agreement page.

5. Select I accept the terms of the license agreement, and click Next. The setup shows the 
installation options.

6. Select Custom and click Next. 
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7. The setup shows a list of HP CR features. Select Component Package. Clear all the other features 
that you are not installing at this time. Click Next.

8. The setup checks the system for installation requirements and displays the results. Click Next to 
continue the installation.

NOTE:  The setup cannot continue until all required components are installed. (Double-click an item in the 
list for more information.) If any required components were not detected, click Cancel and Yes to exit the 
setup and install the components that are required to complete the installation.

The setup requests logon credentials for the HP CR service account. The NT Domain and User 
Name fields are populated automatically based on the current Windows user.
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9. Enter the HP CR service account logon credentials.

a In the NT Domain field, enter the Windows domain name.

b In the User Name field, enter the user name.

c In the Password and Confirm Password fields, enter the user password.

d Click Next.

10. The setup validates the user account and then shows installation settings. Review the installation 
settings and click Next to start the installation. The setup installs the selected component and 
displays a message indicating that the installation is complete. Click Finish.

NOTE:  If other installation features are included, the setup might request additional information before 
displaying installation settings.

After the remote Composer is installed on the remote system, add the Composer to the Compose 
component on the HP CR server, as described below.

6-3 Adding the Composer to the HP CR server
Complete this procedure if you are adding a new Composer or replacing an existing Composer with a new 
one.

TIP:  If you are replacing a local Composer with a new remote Composer, you must first remove the local 
Composer (as described in the procedure below) so the new Composer can be added without a license 
key. (If you keep the local Composer and add a remote Composer, you would need another license key.)

For each additional Composer you add to your environment, you must get a license key from your software 
representative. 

1. Click Start > All Programs > HP Capture and Route > HP Capture & Route Server 
Administrator to open the HP CR Server Administrator. 

2. In the console tree, click Components. 
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3. Double-click Compose in the details pane to open the Properties for Composer page.

4. Click the Composers tab.

5. If you are not replacing a Composer, but are just adding a new one, continue with Step 6.

If you are replacing the local Composer with a new remote Composer, select localhost, click 
Delete, and then click Yes to remove the local Composer. You can continue with Step 6.

TIP:  The local Composer must be removed first so that the new Composer can be added without a license 
key.

6. Click Add. The Add Composer Package page opens. In the Server Address text box, enter the 
remote Composer machine name or IP address. Click OK.

The Composer is added to the Compose component.

7. Click OK to close the Composer page. 

The remote Composer begins performing conversion tasks immediately.
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7 Installing a remote modem server

A modem server is a server that sends and/or receives faxes for the HP CR server. It consists of Dialogic 
Brooktrout System Software, Brooktrout System Drivers, and HP CR modem server software. An HP CR 
server supports multiple modem servers, all managed by the HP CR connector for Telco on the HP CR 
server. A remote system that hosts a modem server is called a remote modem server.

Figure 7-1 Server with a local modem server and remote modem servers

The HP CR server shown here has 
a local modem server and three 
remote modem servers with an HP 
CR connector for Telco managing 
all of them. This is an example of a 
supported configuration.

The HP CR server can run without a local modem server, and the environment can have more Telco 
connectors or fewer remote modem servers than shown in this illustration. The HP CR connector for Telco 
can be configured to monitor one Telco share, an intermediary repository for inbound and outbound faxes.

Modem servers are supported in these configurations:

 HP CR connector for Telco with one modem server in the LAN

 HP CR connector for Telco with multiple modem servers in the LAN

 Multiple HP CR connectors for Telco, each with one or more modem servers in the LAN

Using multiple HP CR connectors for Telco delivers additional benefits to environments with special faxing 
requirements:

 Reduced faxing costs - With multiple HP CR connectors for Telco, the HP CR server can be 
configured to deliver faxes using the modem server closest to the destination. This can reduce long 
distance telephones charges.

 Failover support - Through rules, the HP CR server can be configured to route outbound faxes to 
one HP CR connector for Telco but if delivery fails, the HP CR server can route the outbound faxes 
to another HP CR connector for Telco.

 Increased efficiency - Multiple HP CR connectors for Telco provide built-in workload distribution 
based on the HP CR server configuration, HP CR connector for Telco configuration, and rules.
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When scaling an environment with additional connectors or components, you should contact your software 
representative who can assist you in correctly identifying potential bottlenecks in the system based on 
workload and other factors. Your software representative can provide helpful information on the overall 
impact of increasing the system speed and efficiency.

The remainder of this section describes:

Requirements for a remote modem server (62)

Installing and testing Brooktrout system software (62)

Installing the remote modem server (63)

Detecting channels on the modem server (65)

Configuring a path to the Telco share directory (66)

For additional information (including optional configuration and troubleshooting), refer to the HP CR 
administrator online help.

7-1 Requirements for a remote modem server
A remote modem server requires a system that meets the minimum Hardware and software requirements 
and Additional installation requirements listed for the HP CR server. In addition, a remote modem server 
requires:

 Windows NT domain computer that always runs in the same domain as the HP CR server

 Dual core processor, 2 GHz, 2GB of RAM for one T1line (2-24 channels) or 4 GB RAM for two T1 
lines (24-48 channels), RAID 5W with 100 GB of disk space, and Microsoft mouse or compatible 
pointing device 

 Windows 2012 64-bit, Windows 2008 R2 64-bit

 Microsoft Internet Explorer 7 or later

 Access to a network copy of the HP CR server setup

 Windows user account that belongs to the local Administrators group

 Installation of at least one supported Dialogic Brooktrout System Software. For additional 
requirements on installing the fax board and Brooktrout System Software, see Installing and 
configuring a Dialogic modem driver.

7-2 Installing and testing Brooktrout system 
software

Before a remote modem server is installed with Dialogic Brooktrout SR140 fax channels, install the 
Brooktrout System Software. Refer to Installing and configuring a Dialogic modem driver.

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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7-3 Installing the remote modem server
1. Log in to the system where you will install the remote modem server using an account that belongs 

to the HP CR Administrators group.

2. Navigate to the network where the HP CR server setup files are located.

3. Run: \HP CR\setup.exe
The system runs the Prerequisite checks. When the Successful Summary appears, click Remote 
Modem Server. The InstallShield wizard opens with a welcome message. Your system configures 
for installation.

4. Click Next. The setup shows the License Agreement page.

5. Select I accept the terms of the license agreement and click Next. The setup shows the 
installation options. Select Custom and click Next. The setup shows a list of HP CR features.
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6. Select Modem Server. Clear all the other features you are not installing at this time. Click Next. 

7. The setup checks the system for installation requirements and displays the results. Click Next to 
continue the installation.

NOTE:  The setup cannot continue until all required components are installed. (Double-click an item in the 
list for more information.) If any required components were not detected, click Cancel and Yes to exit the 
setup and install the components that are required to complete the installation.
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The setup requests logon credentials for the HP CR service account. The NT Domain and User 
Name fields are populated automatically based on the current Windows user.

8. Enter the HP CR service account logon credentials.

a In the NT Domain field, enter the Windows domain name.

b In the User Name field, enter the user name.

c In the Password and Confirm Password fields, enter the user password.

NOTE:  If other installation features are included, the setup might request additional information before 
displaying installation settings.

9. Review the installation settings and click Next to start the installation. The setup installs the modem 
server and displays a message indicating that the installation is complete.

10. Click Finish.

Continue by detecting the channels on the modem server, as described below.

7-4 Detecting channels on the modem server
After installing the remote modem server, you must configure the HP CR connector for Telco to detect the 
channels on the remote modem server. When the channels have been detected, the properties of each 
channel, such as send and receive properties, can be configured in the HP CR connector for Telco 
properties.

To detect the channels on the modem server:

1. Click Start > All Programs > HP Capture and Route > HP Capture & Route Server 
Administrator to open the HP CR Server Administrator.

2. Click Connectors in the console tree, and double-click Telco in the details pane.
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The Properties page opens.

3. Click Channels and then click Detect Channels. The Detect Channels page opens. 

4. In the Modem Server Address text box, enter the remote modem server machine name or IP 
Address. Click Detect Now.

5. Configure the channels if necessary, and then click OK.

For more information on configuring the channels, refer to the HP CR administrator online help.

7-5 Configuring a path to the Telco share directory
After you detect the channels, you can configure the path to the Telco share directory to be a UNC path.

NOTE:  The HP CR server UNC path is filled in by default. 

If you specify a full path, when the configuration file is written to the remote modem server, the remote 
modem channels will look for “c:\” for the send and receive queues. But they should be looking at the HP 
CR server for the queues. So, you need to configure the path:

1. Click Start > All Programs > HP Capture and Route > HP Capture & Route Server 
Administrator to open the HP CR Server Administrator. 

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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2. Click Connectors in the console tree, and double-click Telco in the details pane. The Properties 
page opens. 

3. Click Advanced to open the Telco Advanced Properties page.

In the Path to telco share directory text box, the HP CR server UNC path is filled in by default. 

4. Modify the path, if necessary. For example, you can specify the system name instead of providing 
the IP address. Add a trailing backslash at the end (for example: \\123.4.5.678\telcoshare\). 

5. Click OK and then OK again to save your changes and close the Properties page.
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8 Installing the Remote HP CR Intelligent 
Device Client

The Intelligent Device Client is installed on the HP CR server with a complete installation. You can install 
the Intelligent Device Client on a remote system using the instructions in this section.

The remainder of this section describes:

Requirements for the HP CR Intelligent Device Client (69)

Installing the remote HP CR Intelligent Device Client (70)

Configuring the remote HP CR Intelligent Device Client (72)

For additional information (including optional configuration and troubleshooting), refer to the HP CR 
administrator online help.

8-1 Requirements for the HP CR Intelligent Device 
Client

8-1-1 Basic requirements
The HP CR Intelligent Device Client requires a system that meets the minimum Hardware and software 
requirements (7) and Additional installation requirements (8) listed for the HP CR server. In addition, an HP 
CR Intelligent Device Client requires:

 A Windows NT domain system that runs in the same domain as the HP CR server and is not a 
domain controller. If the system is in a different domain, the domain must have bidirectional trust with 
the HP CR server domain.

 Pentium III-compatible processor, 1 GHz, 512 MB RAM, 500 MB available hard disk space, and 
Microsoft mouse or compatible pointing device

 Windows 2012 64-bit, Windows 2008 R2 64-bit

 IIS with the following components: Common Files, World Wide Web Service, and Internet 
Information Services Manager

 Access to a network copy of the HP CR server setup

 Windows user account that belongs to the HP CR Administrators group

8-1-2 HTTP and HTTPs requirements
The Intelligent Device Client supports HTTP and HTTPs connectivity to the HP CR End User Interface. For 
HTTPs connectivity, you must perform the following tasks prior to installing the Intelligent Device Client on 
a remote system.

 Create and install a CA certificate on the default web site in IIS.

 HTTPs for use with Embedded Device Client for HP OXPd v1.6

 HTTPs for use with Embedded Device Client for HP OXPd v1.4

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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TIP:  To set up a CA certificate using Microsoft Certificate Services, refer to the HP Capture and Route (HP 
CR) Embedded Device Client Installation Guide. For a CA certificate issued by a third party, use the 
certificate authority’s instructions and apply the certificate to the default web site in IIS.

 Enable Secure Socket Layer (SSL) on the default web site in IIS. Refer to the HP Capture and Route 
(HP CR) Embedded Device Client for HP OXPd Installation Guide.

8-1-3 Required COM permissions for the remote HP CR 
Intelligent Device Client

When performing a typical HP CR server installation, the HP CR Intelligent Device Client is installed by 
default. No separate client installation is necessary. For custom installations, you can uncheck the HP CR 
Intelligent Device Client option from the list of components to install.

If you need to install the HP CR Intelligent Device Client on a separate system, you must configure the 
following DCOM permissions for the Anonymous_User user. 

1. Log in to the system where you will install the HP CR server using an account that belongs to the 
Administrators group.

2. Click Start > Control Panel > Administrative Tools > Component Services. 

3. In the console, expand Component Services > Computers.

4. Right-click My Computer and select Properties from the dropdown menu. 

5. Click COM Security.

6. In the Access Permissions section, click Edit Limits. The Access Permission page opens. 

7. For user Anonymous_logon, select Local Access and Remote Access permissions. 

8. Click OK to close the page.

9. In the Launch and Activate Permissions section, click Edit Limits. The Launch Permissions 
page opens. 

10. For user Anonymous_logon, select Local Launch, Remote Launch, Local Activation, and 
Remote Activation permissions. 

11. Click OK and then OK again to close the Properties page. 

8-2 Installing the remote HP CR Intelligent Device 
Client

1. Log in to the system using an account that belongs to the HP CR Administrators group.

2. Navigate to the network where the HP CR server setup files are located.

3. Run:

\MessageServer\setup.exe

The InstallShield wizard opens, configures your system, and displays the welcome message.

4. Click Next. The setup shows the License Agreement page.

5. Read the agreement and select I accept the terms of the license agreement option.

http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf
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6. Click Next. The setup shows the installation options.

7. Select Custom. Click Next. The setup shows a list of HP CR features.

8. Select Intelligent Device Client. Clear any other feature you are not installing at this time.
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9. Click Next. The setup checks the system for installation requirements and displays the results.

NOTE:  The setup cannot continue until all prerequisite components are installed. (Double-click an item in 
the list for more information.) If any required components is missing, click Cancel and exit the installation 
setup. Install the components, then install HP CR Intelligent Device Client. 

10. Click Next. The setup shows installation settings.

11. Review the installation settings. Click Next to start the installation. The setup installs the selected 
component and displays a message indicating that the installation is complete.

12. Click Finish.

13. Continue to configure the remote Intelligent Device Client, as described below.

8-3 Configuring the remote HP CR Intelligent 
Device Client

8-3-1 Specifying the HP CR server
When you install the Intelligent Device Client on a remote machine, you must specify the HP CR server IP 
Address in OmISAPIU.xml.

To specify HP CR server name or IP address in OmISAPIU.xml:

1. Go to:

...\HP\HPCR\WebAPI\WebAPI\Scripts

2. Open OmISAPIU.xml for editing.

3. Locate the ServerName node. 

4. Specify the HP CR server name or IP address. For example:

<ServerName>12.123.4.5</ServerName>
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NOTE:  If the server is part of a cluster, the following setting should be made in the file:

<Server Name="MessageServer"><ServerName>
Primary_Server_name</ServerName>

<Server Name="MessageServer"><ServerName>Secondary_Server_name</ServerName>
</Server>

5. Save and close the file.

8-3-2 Adding the remote server’s name to DCOM
1. Add the remote server’s name to DCOM on the HP CR server. For example: VMTesting$.

NOTE:  You must append the name with a dollar sign ($).

2. Select Computers in the Object Types when adding the server name.

3. Reboot the HP CR server.

8-3-3 Adding the application pool logon account to the HP CR 
Admins group

The application pool for the WebAPI is the WebAPI managing the worker process that handles requests 
from other Embedded Device Client for HP OXPd applications. By default, they run as Local System.

NOTE:  If the security policy in the LAN does not permit the application pool to run as Local System, the 
application pool identity can be reconfigured using any account that belongs to the Domain Users group. 

If you change your login to a network account, Integrated Windows Authentication will not work for the 
virtual directories that use the application pool. The work-around requires kerberos protocol changes in the 
active directory.

If necessary, modify the application pool identity. For instructions, consult the Windows documentation on 
IIS.

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/c9b5db6f-874e-4ec9-93ed-1733367c117b.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/c9b5db6f-874e-4ec9-93ed-1733367c117b.mspx?mfr=true
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If the Intelligent Device Client is installed on a remote system, add the application pool logon account to 
the HP CR Admins group which has the required Distributed COM permissions to communicate with the 
HP CR server. For instructions, see Creating the HP CR Admins group (9).

NOTE:  When the Intelligent Device Client is installed on the HP CR server and both application pools run 
as Local System, you do not need to modify the application pool identity.

8-3-4 Other configurations
Other configurations include:

 Modifying the directory security configuration of virtual directories (optional)

For instructions, see Optional configuration: Modifying the directory security configuration of virtual 
directories (47).
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9 HP CR Device Clients for HP OXPd

As an intranet-based application for multifunction devices and business systems, HP CR supports software 
solutions to deploy the HP CR Device Client to multifunction devices running OXPd SDK v1.6.x and OXPd 
SDK v1.7.2. 

Instructions for installing The HP CR Embedded Device Client are provided in the HP Capture and Route 
(HP CR) Embedded Device Client Installation Guide.

If you have HP MFP devices that are Group 10 devices and support OXPd v1.4, follow the instructions for 
installing the Embedded Device Client for HP OXPd v1.4.

http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf


HP CR Device Clients for HP OXPd

76



HP CR End User Interface

77

10 HP CR End User Interface

The HP CR End User Interface, Web User Interface, is an intranet-based web application that provides 
network users a convenient method of delivering documents. Web User Interface is the customizable, tile-
based HP CR client from which users can access Applications integral to their workflow.

The intuitive Web User Interface Homepage presents the user with several application tiles, from which 
they can create Messages, work with Distributions and Files, and set preferences. The Application options 
available to user groups are defined in the System Administrator. 

HP CR also includes Legacy Web User Interface, the legacy End User Interface that offers authorized 
access to the Administration section (only available through Legacy Web User Interface), where users can 
manage routing tables, hold calendars, and the Help Desk view.

Messages and distributions

Users can send messages and distributions electronically and from hard copy. In both cases, the End User 
Interface delivers the document as an electronic file attachment using the recipient information.

 For messages and distributions sent electronically, users manually add a recipient or choose a 
distribution, select and add an attachment, review options and send. The system processes it using 
the associated routing information.

 For messages and distributions sent starting with a hard copy, users can print Routing Sheets to 
bring to an MFP with the document, or they can sign-in to the device and use the distributions 
associated with authenticated buttons on the device, such as Scan to Me.

For more information on messages and distributions, and exact steps for working with them in the End User 
Interface, see the HP CR User Guide.

Distribution Collections

Users can create their own Distributions or make use of any Distribution Collections to which their user 
group is assigned in the HP Server. Users cannot edit an existing distribution within a Distribution 
Collection, but they can modify it and use Save As to generate a new one based on the original settings. 

For more information on working with Distribution Collections, refer to Chapter 4: Distributions in the HP 
CR User Guide.

Administration view

Authorized users of the Legacy Web User Interface can use the Administration section to manage routing, 
calendars, and the Help Desk. 

 Use Routing to manage correlations between fax numbers, devices, and document Hold statuses. 

 Use the Calendar to manage Hold time settings.

 Use the Help Desk to view processing details and history. Also search, cancel and re-send 
messages and related documents. 

For more information about using the Administration section, see Using the Administrator Web Client 
Views Management tool to set up primary options.

Installation and Configuration

The remainder of this section contains instructions on installing and configuring both HP CR End User 
Interfaces:
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 Web User Interface installation and configuration (78)

 Legacy Web User Interface installation and configuration (88)

10-1 Web User Interface installation and 
configuration

These instructions are written for HP CR Server Administrators with detailed knowledge of the HP CR 
server and clients.

HP CR Web User Interface requirements (78)

Installing the HP CR Web User Interface (79)

Required configuration (93)

For additional information (including optional configuration and troubleshooting), refer to the HP CR 
administrator online help.

For instructions on how to use the HP CR End User Interface, consult the HP Capture and Route (HP CR) 
User Guide.

Figure 10-1 Web User Interface

The default Web User Interface Homepage presents the user with a series of Application tiles.

10-1-1 HP CR Web User Interface requirements

10-1-1-1 Basic requirements

IMPORTANT:  You can install HP CR Web User Interface on the system running the HP CR server. If you 
install HP CR Web User Interface on a system that is not running the HP CR server, you must configure 
DCOM permissions so that the Web User Interface server can access the HP CR server DCOM objects.

The requirements for the HP CR Web User Interface are:

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/webclient/webclient_en.pdf

http://www.omtool.com/documentation/hpcr/1.5.0/webclient/webclient_en.pdf
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 Windows 2012 64-bit, Windows 2008 R2 SP-1 64-bit

For Windows 2012 64-bit: Internet Information Services (IIS) v8 

For Windows 2008 64-bit: Internet Information Services (IIS) v7 

 IIS (Windows component)

NOTE:  For IIS v7 or later, configure to allow Active Server Pages. This configuration is located in the Web 
Service Extensions node in the IIS console tree.

 Microsoft .NET Framework v4.0 redistributable package (Installing Legacy Web User Interface, 91)

 Microsoft Internet Explorer 7 or later

 Acrobat Reader 7.0 or later

 Internet connection

10-1-1-2 Supported Email Applications

 Microsoft® Outlook® 2007 or higher (Outlook Express is not supported)

The HP CR End User Interface has a Browse Address book option for new messages page. This 
feature is available for Microsoft Outlook clients only. 

NOTE:  The HP CR Web Apps user can choose an email address from the Microsoft Outlook Address 
Book only if the Outlook client is installed and configured on the client system. (Also see Enabling the 
Address Book lookup functionality, 97.)

When HP CR Web Apps is configured to integrate with an Address Book for a supported email application, 
the email application must be selected as the Windows default email application. For more information, 
consult Windows help.

10-1-1-3 User requirements: email account

The HP CR Web Apps users must have an email account created for them using the mail server (Microsoft 
Exchange Server).

IMPORTANT:  The mail server for any email account created must be installed on the same domain where 
the HP CR server is installed. 

This is necessary because the HP CR Web Apps queries the Active Directory attributes like “mail” and 
“proxyAddresses”. The “proxyAddresses“attribute is added to the Active Directory properties only if an 
Microsoft Exchange Server is installed in the same domain as the Active Directory. 

10-1-1-4 User requirements: full permissions

IMPORTANT:  Full permissions to the Web Apps installation folder for all domain users (including the 
application pool account user) is required when Web Apps is installed to a non-default location with a 
custom virtual directory name. 

10-1-2 Installing the HP CR Web User Interface
The Web User Interface setup does all of the following:

 Installs the Web User Interface program files
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 Creates a virtual directory in IIS and configures IIS authentication

 Configures Web User Interface with the HP CR server location, and the mail system identity and 
location

10-1-2-1 Installing Web User Interface

If you have used HP CR End User Interface before, you must keep the deprecated client application and 
set up files in your system, as deleting those files may interfere with the server usage.

1. Log on to the system where Web User Interface is being installed using an account that belongs to 
the local Administrators group.

2. Navigate to a network folder containing the Web User Interface setup files and run setup.exe. The 
InstallShield Wizard opens to the Welcome screen. Click Next. 

TIP:  The Web User Interface setup is installed with a complete HP CR server installation in \Program 
Files (x86)\HP\HPCR\Clients\Web Apps. Immediately following the HP CR server installation, only 
the HP CR service account has permissions to access client setup programs on the HP CR server, but 
additional users can be granted permissions if necessary.

3. The Destination Folder screen appears.

If you need to change the destination folder, click Change and follow the prompts. Then click Next. 
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4. The IIS Virtual Directory screen appears. 

Name the Web User Interface by entering the IIS Virtual Directory name here. The default is HPCR. 
You can change the virtual directory name if necessary. Then click Next.

NOTE:  The virtual directory name is used to create a virtual directory in IIS under Default Web Site.

5. The Message Server screen appears. 

Enter the Message Server name. If the HP CR server is running in the system in which you are 
installing this client, the name is entered by default. Click Next. 

NOTE:  If you are installing the Web User Interface in a cluster environment, you can enter multiple 
Message Server names in this field, separated by commas. For example: Server1, Server2.
If you need to add servers post-installation, see Configuring the Web User Interface for a cluster 
environment (87) for more information.
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6. The Message Server Credentials screen appears. 

Enter the Service Account name and Password used by the HP CR Server, and click Next.

7. On the Authentication Type screen, select an Authentication type and enter the Authentication 
server name. Click Next. 

8. The Ready to Install the Program screen appears. Click Install. 
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The InstallShield wizard installs the client and the Completed screen appears. Click Finish to exit 
the wizard. 

9. To launch the Web Apps End User Interface, open a web browser with a URL of 
https://messageservername/virtualdirectoryname.

10-1-2-2 Required DCOM permissions when installing on a remote system

When you install HP CR End User Interface on a remote system, you must configure the following DCOM 
permissions on the HP CR server. Without this configuration, the HP CR server cannot communicate with 
the remote clients. For DCOM configuration instructions, see Configuring required COM permissions for 
launching the remote End User Interface (85).

10-1-3 Required configuration

10-1-3-1 Enabling integrated Windows authentication

The End User Interface authenticates users based on their Windows logon credentials. The logon 
credentials are either passed transparently from the client to the web server or entered manually by the 
user at the beginning of each session. The login method depends on how authentication is configured; both 
methods are described in the configuration instructions.

Configure Windows authentication on the web server and then configure Internet Explorer on clients.

Configuring integrated Windows authentication on the web server

1. Log on to the web server using an account that belongs to the local Administrators group and start 
IIS.

2. Expand the server running the End User Interface and expand Default Web Site.

3. Click the virtual directory for the End User Interface. (The default name is WebClient.) The End 
User Interface program files appear in the details pane.

4. Right-click WebClient in the details pane and select Properties.

NOTE:  When right-clicking WebClient in IIS for Windows 2008 server, you do not get a Properties option. 
Instead, for 2008 server, double-click authentication and enable anonymous access there.

5. Go to the Directory Security tab.

6. Go to Authentication and access control and click Edit. The Authentication Methods page 
opens.

7. Go to Authenticated access section and select Integrated Windows Authentication option. 

8. Click OK to save the changes and close the Authentication Methods page.

9. Click OK to close the Properties page.

Configuring integrated Windows authentication on clients running Internet Explorer 7.0/6.0

You must configure Integrated Windows Authentication on all clients running Internet Explorer 7.0/6.0.

1. Log on to the client using an account that belongs to the local Administrators group and start Internet 
Explorer.

2. Open Internet Explorer and click Tools > Internet Options.

3. Click the Security option. 

4. Select Internet or Local Intranet depending on your default zone, and click Custom level. 
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The Security Settings page opens. 

5. Scroll down to the User Authentication section and make the following changes:

 To authenticate the Windows user transparently, select Automatic logon with current user 
name and password. 

 To prompt the Windows user to enter logon credentials at the beginning of each session, 
select Prompt for Username and Password. 

6. Click OK to close the Internet Options page. 

7. Close the Internet Explorer page.

8. Close all other open instances of Internet Explorer for the change to take effects.

10-1-3-2 Adding the End User Interface URL to the list of trusted sites on a client 
system

You must add the HP CR End User Interface URL to the list of trusted sites on all client systems which will 
browse to the HP CR End User Interface. 

1. Log on to the client system using an account that belongs to the local Administrators group and open 
Internet Options. (It is accessible from Control Panel or Internet Explorer.)

2. Go to the Security tab.

3. Select Trusted sites and click Sites.

4. Enter the End User Interface URL and click Add.

5. Clear Require server verification (https:) for all sites in this zone if this option is selected.

6. Click Close to close the Trusted Sites dialog. 

7. Click Apply to save the changes and click OK to close the dialog box.

The End User Interface URL is now added to the list of trusted sites. To verify that the system recognizes 
the End User Interface URL as a trusted site, start Internet Explorer and go to the End User Interface URL. 
Verify that End User Interface loads. (Depending on your Windows Integrated Authentication configuration, 
you may need to login. 

10-1-3-3 Selecting a network printer

1. Be sure the printer driver is installed on the HP CR server and that the printer was added to the 
Groups configuration section of the HP CR Server Administrator, as described in Adding network 
printers (44).

NOTE:  Before the network printers are listed in the HP CR End User Interface, the network printers must 
be added to the Jobs > Printers section of Group Properties in the HP CR Server Administrator.

The HP CR End User Interface will read the list of configured network printers on the HP CR server.

2. Log in to the HP CR Web User Interface application.

3. Click the Preferences tile. The Preferences page opens. 
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4. Click the Options tile to access the Printer field. 

5. In the Printer field, enter the printer Name or IP address of interest and click Save.

NOTE:  If you do not save your preferences, your configuration is valid for the current session only. The 
HP CR Web User Interface will not remember your choices if you log out or open a new session. 

10-1-3-4 Configuring required COM permissions for launching the remote End 
User Interface

Before you can launch a remote End User Interface, you must configure COM permissions for 
Anonymous_logon on the HP CR server. To do so:

1. Log in to the system running the HP CR server using an account that belongs to the Administrator.

2. Click Start > Control Panel > Administrative Tools > Component Services. 

3. In the console, expand Component Services > Computers.

4. Right-click My Computer and select Properties from the drop-down menu. 

5. Click COM Security.

6. In the Access Permissions section, click Edit Limits. The Access Permission page opens. 

7. For user Anonymous_logon, select Local Access and Remote Access permissions. 

8. Click OK to close the page.

9. In the Launch and Activate Permissions section, click Edit Limits. The Launch Permissions 
page opens. 

10. For user Anonymous_logon, select Local Launch, Remote Launch, Local Activation, and 
Remote Activation permissions. 

11. Click OK and then OK to close the Properties page. 

10-1-3-5 Creating a new Web User Interface Profile

1. In the HP CR Server Administrator, go to the Configuration node and right-click Web Apps > New 
> Profile. The New Profile Properties screen appears. 
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2. Enter a profile Name, and optionally, a Description.

3. Go to the Applications tab, click Add and (one at a time) select the applications of interest from the 
various options in the drop-down menu. 

4. For example, click Add > Messages > Inbox. The Inbox Application Properties screen opens. 
Here you can further refine specific Inbox properties as needed. 

5. Click OK to exit the application Properties screen. When you return to the New Profile Properties 
screen, you will see the selected Application added to the list. 

6. In the Features tab, click Add and select any Feature you want to associate with the Profile. Options 
include: DocumentLink, Favorites, PrinttoWeb, ScantoWeb, and SendtoWeb. 
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7. As it does with Applications, a Properties screen appears for any Feature you select. You can 
further refine a Feature’s characteristics in its Properties page. 

8. Click OK to exit the Features Properties screen, and click OK again.

9. Your new profile appears in the Web Apps list.

To edit properties of an existing Profile, right-click the profile of interest and select Properties to access 
Profile Properties.

10-1-3-6 Adding a Web User Interface Profile to a User Group

1. Go to Configuration > Groups, right-click the group of interest and select Properties.

2. In the Group Properties screen, click Clients > Web. 

Make sure Enable members of this group to use the following web view is selected. 

3. Click the Profile drop-down list and select the Profile of interest. Click OK.

The user group is now updated to use the new Profile in Web Apps.

10-1-3-7 Configuring the Web User Interface for a cluster environment

In order to enable the Web User Interface to communicate with a server cluster, the Administrator needs 
to edit the AppSettings.json file on the HP CR Server.
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NOTE:  If your cluster environment is already set up at the time of the Web User Interface installation, you 
can enter multiple Message Server names on the Message Server installation screen (separated by 
commas). For more information, see Installing the HP CR Web User Interface (79).

1. Navigate to the WebApps configuration file in 

\Program Files (x86)\HP\HPCR\Clients\Web Apps

and open AppSettings.json in a text editor.

2. In AppSettings.json, the “MessageServer” property can take multiple server names. 

At the “MessageServer” property, add the secondary server name as a quoted string, separated 
by a comma, as shown in the following example:

{

"AppSettings": {

"ProductName": "HP Capture and Route Apps",

"ProductLogo": "~/images/logo.svg",

"ProductLogoFlyover": "~/images/logo-flyover.svg",

"MessageServer": [ "server1", "server2" ],

"Help": "%HelpUrl%"

},

3. Save and close the AppSettings.json file.

10-1-3-8 Configuring prompts

See the HP CR administrator online help.

10-1-3-9 Configuring additional custom options

See the HP CR administrator online help.

10-2 Legacy Web User Interface installation and 
configuration

These instructions are written for HP CR Server Administrators with detailed knowledge of the HP CR 
server and clients.

HP CR Legacy Web User Interface requirements (89)

Installing HP CR Legacy Web User Interface (90)

Required configuration (93)

Optional configuration - Customizing the HP CR Legacy Web User Interface (96)

Optional configuration - Configuring the HP CR Server Administrator (104)

For additional information (including optional configuration and troubleshooting), refer to the HP CR 
administrator online help.

For instructions on how to use the HP CR End User Interface, consult the HP Capture and Route (HP CR) 
User Guide.

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/webclient/webclient_en.pdf

http://www.omtool.com/documentation/hpcr/1.5.0/webclient/webclient_en.pdf

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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NOTE:  The following features are only available for use with the Legacy Web User Interface Client: 

- Routing Table management
- Calendars for Fax Release Schedules
- Help Desk features for searching and managing messages and distributions (viewing, resending, 
canceling, etc.)

Figure 10-2 Legacy Web User Interface 

The default view of Legacy Web User Interface presents the user with a series of options.

10-2-1 HP CR Legacy Web User Interface requirements

10-2-1-1 Basic requirements

IMPORTANT:  You can install the HP CR Legacy Web User Interface client on the system running the HP 
CR server. If you install Legacy Web User Interface on a system that is not running the HP CR server, you 
must configure DCOM permissions so that the Legacy Web User Interface server can access the HP CR 
server DCOM objects.

The requirements for HP CR Legacy Web User Interface are:

 Windows 2012 64-bit, Windows 2008 R2 SP-1 64-bit

For Windows 2012 64-bit: Internet Information Services (IIS) v8 

For Windows 2008 64-bit: Internet Information Services (IIS) v7 
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 IIS (Windows component)

NOTE:  For IIS v7 or later, configure to allow Active Server Pages. This configuration is located in the Web 
Service Extensions node in the IIS console tree.

 Microsoft .NET Framework v4.0 redistributable package (Installing Legacy Web User Interface, 91)

 Microsoft Internet Explorer 7 or later

 Acrobat Reader 7.0 or later

 Internet connection

10-2-1-2 Supported Email Applications

 Microsoft® Outlook® 2007 or higher (Outlook Express is not supported)

The HP CR End User Interface has a Browse Address book option for new messages page. This 
feature is available for Microsoft Outlook clients only. 

NOTE:  The HP CR Legacy Web User Interface user can choose an email address from the Microsoft 
Outlook Address Book only if the Outlook client is installed and configured on the client system. (Also see 
Enabling the Address Book lookup functionality, 97.)

When HP CR Legacy Web User Interface is configured to integrate with an Address Book for a supported 
email application, the email application must be selected as the Windows default email application. For 
more information, consult Windows help.

10-2-1-3 User requirements: email account

The HP CR Legacy Web User Interface users must have an email account created for them using the mail 
server (Microsoft Exchange Server).

IMPORTANT:  The mail server for any email account created must be installed on the same domain where 
the HP CR server is installed. 

This is necessary because Legacy Web User Interface queries the Active Directory attributes like “mail” 
and “proxyAddresses”. The “proxyAddresses“attribute is added to the Active Directory properties only if an 
Microsoft Exchange Server is installed in the same domain as the Active Directory. 

10-2-1-4 User requirements: full permissions

IMPORTANT:  Full permissions to the Web Client installation folder for all domain users (including the 
application pool account user) is required when the Legacy Web User Interface client is installed to a non-
default location with a custom virtual directory name. 

10-2-2 Installing HP CR Legacy Web User Interface
The Legacy Web User Interface setup does all of the following:

 Installs the Legacy Web User Interface program files

 Creates a virtual directory in IIS and configures IIS authentication

 Configures Legacy Web User Interface with the HP CR server location, and the mail system identity 
and location
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10-2-2-1 Installing Legacy Web User Interface

If you have used HP CR Legacy Web User Interface before, you must keep the deprecated client 
application and set up files in your system as deleting those files may interfere with the server usage.

1. Log on to the system where Legacy Web User Interface is being installed using an account that 
belongs to the local Administrators group.

2. Navigate to a network folder containing the setup files and run setup.exe.

TIP:  The Legacy Web User Interface setup is installed with a complete HP CR server installation in 
\Program Files\HP\HPCR\Clients\Web. Immediately following the HP CR server installation, only 
the HP CR service account has permissions to access client setup programs on the HP CR server, but 
additional users can granted permissions if necessary.

The system runs the Prerequisite checks. When the Successful Summary appears, click Web 
Client Install. The InstallShield wizard configures your system and the Welcome message 
appears.

3. Click Next. The Destination Folder screen appears.

4. Change the destination folder if necessary by clicking Change and then following the prompts. Click 
Next. On the next screen, the IIS Virtual Directory name for the End User Interface appears.

5. Change the virtual directory name if necessary. The default is WebClient. Click Next. 

NOTE:  The virtual directory name is used to create a virtual directory in IIS under Default Web Site.
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The setup prompts you to enter the HP CR server name. If you are installing the client in a system 
which has the HP CR server running, the name is automatically entered (by default). Click Next. 

6. In the Server Credentials screen, enter the Service Account name and Password used by the HP 
CR Server. Click Next. 
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7. The setup prompts you to choose the Authentication type and enter the Authentication server 
name. Click Next. 

8. The Ready to Install the Program page appears. 

9. Click Install. The client is installed. The InstallShield wizard indicates when the installation is 
complete. 

10. To launch the End User Interface, check the Launch the program box.

11. Click Finish to close the InstallShield wizard. 

When installation is complete, a web browser opens and HP CR Legacy Web User Interface is launched 
with a URL of http://webservername/WebClient.

NOTE:  If you are configured to use a Secure Socket Layer (SSL) connection, manually configure the End 
User Interface URL to be https://webservername/WebClient.

10-2-2-2 Required DCOM permissions when installing on a remote system

When you install HP CR Legacy Web User Interface on a remote system, you must configure the following 
DCOM permissions on the HP CR server. Without this configuration, the HP CR server cannot 
communicate with the remote clients. For DCOM configuration instructions, see Configuring required COM 
permissions for launching the remote Legacy Web User Interface (96).

10-2-3 Required configuration

10-2-3-1 Enabling integrated Windows authentication

The Legacy Web User Interface client authenticates users based on their Windows logon credentials. The 
logon credentials are either passed transparently from the client to the web server or entered manually by 
the user at the beginning of each session. The login method depends on how authentication is configured; 
both methods are described in the configuration instructions.

Configure Windows authentication on the web server and then configure Internet Explorer on clients.
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Configuring integrated Windows authentication on the web server

1. Log on to the web server using an account that belongs to the local Administrators group and start 
IIS.

2. Expand the server running the Legacy Web User Interface and expand Default Web Site.

3. Click the virtual directory for the Legacy Web User Interface. (The default name is WebClient.) The 
Legacy Web User Interface program files appear in the details pane.

4. Right-click WebClient in the details pane and select Properties.

NOTE:  When right-clicking WebClient in IIS for Windows 2008 server, you do not get a Properties option. 
Instead, for 2008 server, double-click authentication and enable anonymous access there.

5. Go to the Directory Security tab.

6. Go to Authentication and access control and click Edit. The Authentication Methods page 
opens.

7. Go to Authenticated access section and select Integrated Windows Authentication option. 

8. Click OK to save the changes and close the Authentication Methods page.

9. Click OK to close the Properties page.

Configuring integrated Windows authentication on clients running Internet Explorer 7.0/6.0

You must configure Integrated Windows Authentication on all clients running Internet Explorer 7.0/6.0.

1. Log on to the client using an account that belongs to the local Administrators group and start Internet 
Explorer.

2. Open Internet Explorer and click Tools > Internet Options.

3. Click the Security option. 

4. Select Internet or Local Intranet depending on your default zone, and click Custom level. 

The Security Settings page opens. 

5. Scroll down to the User Authentication section and make the following changes:

 To authenticate the Windows user transparently, select Automatic logon with current user 
name and password. 

 To prompt the Windows user to enter logon credentials at the beginning of each session, 
select Prompt for Username and Password. 

6. Click OK to close the Internet Options page. 

7. Close the Internet Explorer page.

8. Close all other open instances of Internet Explorer for the change to take effects.

10-2-3-2 Adding the Legacy Web USer Interface URL to the list of trusted sites on 
a client system

You must add the HP CR Legacy Web User Interface URL to the list of trusted sites on all client systems 
which will browse to Legacy Web User Interface. 

1. Log on to the client system using an account that belongs to the local Administrators group and open 
Internet Options. (It is accessible from Control Panel or Internet Explorer.)

2. Go to the Security tab.

3. Select Trusted sites and click Sites.
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4. Enter the End User Interface URL and click Add.

5. Clear Require server verification (https:) for all sites in this zone if this option is selected.

6. Click Close to close the Trusted Sites dialog. 

7. Click Apply to save the changes and click OK to close the dialog box.

The Legacy Web User Interface URL is now added to the list of trusted sites. To verify that the system 
recognizes the URL as a trusted site, start Internet Explorer and go to the End User Interface URL. Verify 
that Legacy Web User Interface loads. (Depending on your Windows Integrated Authentication 
configuration, you may need to login. 

10-2-3-3 Selecting a network printer

1. Be sure the printer driver is installed on the HP CR server and that the printer was added to the 
Groups section of the HP CR Server Administrator, as described in Adding network printers (44).

NOTE:  Before the network printers are listed in the HP CR Legacy Web User Interface, the network 
printers must be added to the Printer tab in the Group section of the HP CR Server Administrator.

The HP CR Legacy Web User Interface will read the list of configured network printers on the HP CR 
server.

2. Log in to the Legacy Web User Interface client.

3. Click Preferences.

The User Preferences page opens listing the user information and options. 

Choose the network printer from the Network Printer drop-down menu. 

Click Save Preferences. 

NOTE:  If you do not save your preferences, your configuration is valid for the current session only. The 
HP CR Legacy Web User Interface will not remember your choices if you log out or open a new session. 
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10-2-3-4 Configuring required COM permissions for launching the remote Legacy 
Web User Interface

Before you can launch a remote Legacy Web User Interface, you must configure COM permissions for 
Anonymous_logon on the HP CR server. To do so:

1. Log in to the system running the HP CR server using an account that belongs to the Administrator.

2. Click Start > Control Panel > Administrative Tools > Component Services. 

3. In the console, expand Component Services > Computers.

4. Right-click My Computer and select Properties from the drop-down menu. 

5. Click COM Security.

6. In the Access Permissions section, click Edit Limits. The Access Permission page opens. 

7. For user Anonymous_logon, select Local Access and Remote Access permissions. 

8. Click OK to close the page.

9. In the Launch and Activate Permissions section, click Edit Limits. The Launch Permissions 
page opens. 

10. For user Anonymous_logon, select Local Launch, Remote Launch, Local Activation, and 
Remote Activation permissions. 

11. Click OK and then OK to close the Properties page. 

10-2-4 Optional configuration - Customizing the HP CR Legacy 
Web User Interface

Use the Administrator Legacy Web User Interface Management tool to set up primary customized options. 
In addition, you can modify the View.default.xml file for secondary customized options. Procedures for both 
primary and secondary options are provided in the following sections.

10-2-4-1 Using the Administrator Legacy Web User Interface Management tool to 
set up primary customized options

You can set up primary customized options to define the ways in which features are displayed with the End 
User Interface.

1. Launch the HP CR Server Administrator.

2. Click Configuration > Web Client Views.
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3. Right-click on View.Default.xml in the results pane. Select Properties. The Web Client View 
Properties page is displayed.

Use the Administrator Legacy Web Client User Interface Management tool for:

 Setting a default Routing Sheet template for use with the Scan to My Files feature (97)

 Enabling the Address Book lookup functionality (97)

 Making fax cover page templates available and setting a default template (99)

 Making Routing Sheet templates available and setting a default template (100)

 Setting tabs/folders that are enabled and specifying a default display (102)

Setting a default Routing Sheet template for use with the Scan to My Files feature

On the Web Client View Properties page (General tab), select a template file from the My Files Routing 
Sheet dropdown.

NOTE:  Typically, the default Routing Sheet template for Personal and Public Distributions is different from 
the template used for the Scan to My Files feature. See also Making Routing Sheet templates available 
and setting a default template (100).

Enabling the Address Book lookup functionality

The end user can use the OCX for Address Book browsing. Enabling this feature requires two steps:

 Selecting the Use Addressbook OCX option on the General tab of the Web Client View 
Properties page

 Enabling ActiveX options on the desktop

After you complete these steps (described below), the End User Interface will have two additional buttons:
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One new button checks that the current The other new button browses the
recipient is in the End User Interface End User Interface user’s LOCAL
user’s LOCAL Address Book. Address Book to add recipients.

Step 1: Enabling the Use Addressbook OCX option:

1. On the Web Client View Properties page (General tab), select the Use Addressbook OCX option 
in the Options section.

2. Click OK to save your changes.

Step 2: Enabling ActiveX options on the desktop

1. In Internet Explorer, open Tools and select Internet Options.

2. Click the Security tab.

3. Click Trusted sites (the green tick mark).

4. Click the Sites button.

5. Enter the Web Client URL in the Add this website to the zone box. Click the Add button to add the 
Web Client URL to the trusted sites.

6. Click Close.

7. Click the Custom level button.

8. Scroll down to ActiveX controls and plug-ins in the Security Settings - Trusted Sites Zone 
page.

9. Set the following conditions:

 Allow previously unused ActiveX controls to run without prompt — select Enable

 Allow Scriptlets — select Enable

 Automatic prompting for ActiveX controls — select Enable

 Binary and script behaviors — select Enable

 Download Signed ActiveX controls — select Enable

 Download unsigned ActiveX controls — select Prompt

 Initialize and script ActiveX controls not marked as safe for scripting — select Prompt

 Run ActiveX controls and plugins — select Enable

 Script ActiveX controls marked safe for scripting — select Enable

10. Click OK and Apply.

11. Close all the instances of Internet Explorer and relaunch the site.
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Making fax cover page templates available and setting a default template

1. On the Web Client View Properties page, click the Fax Coverpages tab.

2. To add a cover page, click the Add button. The Select Fax Coverpages dialog is displayed.
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3. Select a cover page file. Click OK. The file is added to the list. For example:

4. If you want to change the default cover page selection, highlight the name and click Set Default. An 
asterisk (*) appears in the Default column to the left of the cover page name.

5. Click OK to save your changes.

Making Routing Sheet templates available and setting a default template

NOTE:  Typically, the default Routing Sheet template for Personal and Public Distributions is different from 
the template used for the Scan to My Files feature. See also Setting a default Routing Sheet template for 
use with the Scan to My Files feature (97).
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1. On the Web Client View Properties page, click the Routing Sheets tab. To add a Routing Sheet, 
click the Add button.

2. The Select Routing Sheets dialog is displayed.

Select a Routing Sheet file. Click OK. The file is added to the list.

3. If you want to change the default Routing Sheet selection, highlight the name and click the Set 
Default button. An asterisk (*) appears in the Default column to the left of the Routing Sheet name.

4. Click OK to save your changes.
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Setting tabs/folders that are enabled and specifying a default display

1. On the Web Client View Properties page, click the Folders tab. To set the properties for a folder, 
click the Properties button.

2. The Item Properties dialog is displayed.

For each feature (Messages, Distributions, etc.) and related folder (Inbox, Outbox, etc.), select to:

 Display the item for the end user
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 Set the item as the default to display when the user starts to use the End User Interface
(Only one feature and one related folder within the feature can be set as the default to 
display. In the example shown above, Inbox (in Messages) will display by default.)

3. Click OK twice to save your changes.

10-2-4-2 Modifying the View.default.xml file for secondary customized options

You can modify the View.default.xml file for secondary customized options. Two such options are:

 Displaying multiple email accounts (103)

 Configuring row count (104)

Displaying multiple email accounts

The HP CR Legacy Web User Interface displays all email accounts associated with a user. However, if you 
want, you can configure the HP CR End User Interface to display only the primary email address for each 
user. This is useful if users have multiple email addresses associated with their user records in Active 
Directory. 

For example, if ABC company gets purchased by XYZ company, then some users might have two email 
addresses—one with the ABC domain name, and the other with the XYZ domain name. In this instance, 
Active Directory defines the primary email address for users as the address with the XYZ domain name. 
Therefore when you configure the HP CR End User Interface to display only the primary email address of 
each user, users see faxes associated with the XYZ address only.

To configure the HP CR Legacy Web User Interface to display only the primary email address of each user:

1. Navigate to \\HP\WebClient\Configuration on the system where you installed the client.

2. Open the view.default.xml file in Notepad.

3. Locate the <ShowAllProxies> node.
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4. Set the value to false.
If you set the value to true, it will show all primary and secondary email addresses. 

5. Save and close the file. 

Configuring row count

By default, 10 documents are displayed in a page. To configure the row count, configure the folder’s item 
attribute. Generally, there are not a lot of files for a user, as they will have a tight cleanup schedule. 

1. Navigate to \\HP\WebClient\Configuration on the system where you installed the client.

2. Open the view.default.xml file in Notepad.

3. Locate the Folder node for which you want to make the changes. For example:

<Folder type="MyFiles" label="My Files" visible="true" 
image="Myfiles.gif" default="true"
items="" sortexpression="" sortdirection="" filter="">

4. Enter a value for the row count in the item attribute. For example: 

<Folder type="MyFiles" label="My Files" visible="true" 
image="Myfiles.gif" default="true"
items="20" sortexpression="" sortdirection="" filter="">

NOTE:  If no value is mentioned for the item attribute, the default value is 10.

5. Save your changes and close the file. 

6. Perform an iisreset for the changes to take effect.

10-2-5 Optional configuration - Configuring the HP CR Server 
Administrator

The instructions in this section are for the HP CR Server Administrator. All configurations listed are optional 
and are to be used as needed. 

10-2-5-1 Configuring prompts

See the HP CR administrator online help.

10-2-5-2 Configuring additional custom options

See the HP CR administrator online help.

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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11 HP CR Mobile Client

Using the HP CR Mobile Client, HP CR users can preview and send documents from their mobile device, 
create Mobile Reservations for future scanning, and configure Personal Distributions. Access Group and 
Preset Distributions can be configured by the System Administrator and made available on a permission 
basis. Users can also define alerts and set default preferences.

Server Administrators configure permission to use the Mobile Client in Group Properties on the 
Configuration node. For more information on using the Mobile Client, refer to the HP Capture and Route 
(HP CR) User Guide.

When HP CR Mobile Client users make Mobile Reservations, they are creating a Mobile Scan 
Reservation Code for later use at an MFP inside or outside their business network. The system uses the 
Mobile Scan Reservation Code to appropriately distribute the submitted document information. 

If you want to include remote systems in your setup or be able to accept Mobile Reservations from an 
external source, you must properly configure your system ahead of time. This section includes:

Installing the Mobile Device Application (105)

Installing the Mobile Client (106)

Configuring a local IIS system for mobile connectivity (107)

Installing a remote IIS system for mobile connectivity (107)

Configuring a remote IIS system for mobile connectivity (108)

Environment configuration to support HP CR Mobile Clients (108)

11-1 Requirements

 Licenses for both the Mobile Client and the Mobile Server Application

 HP CR Server v1.5.0

 Mobile device running either

 iOS™ 6.x or higher 

 Android™ v4.4 or higher

 Mobile Client application downloaded directly to your device from either 

 iTunes Store®

 Google Play™ store

11-2 Installing the Mobile Device Application
The HP CR v1.5.0 installation program includes the Mobile Client and the Mobile Device Application 
(API). You need to install the HP CR Mobile Device API prior to setting up the Mobile Client. 

NOTE:  You can remotely install the Mobile Device API to a separate server. Depending on the needs of 
your organization, you may prefer to do so for security purposes. 

http://www.omtool.com/documentation/hpcr/1.5.0/webclient/webclient_en.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/webclient/webclient_en.pdf
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To install the Mobile Device API:

1. First, you need to change the DCOM login on the installation server to use the Computer Account 
instead of the Service account. 

2. Refer to steps 1 through 8 in Installing the HP CR server (12) and return here. 

3. At Step 8, on the Setup Type screen, select Custom. All options for the HP CR server installation 
are selected by default. 

4. Clear all options except the Mobile Device API. To continue the installation, click Next.

5. The Prerequisites screen appears as the installer compares your configuration with the required 
setup components and lists the results. Click Next.

6. In the Service Account screen, the setup requests logon credentials for the HP CR computer 
account. By default, the User Name field is populated with the name of the user logged into 
Windows.

Provide the HP CR computer account logon credentials:

a In the NT Domain field, enter the Windows domain name.

b In the User Name field, enter the computer name.

c In the Password and Confirm Password fields, enter the user password.

d Click Next.

7. The setup validates the user account, and you can review the installation settings on the Installation 
Settings screen. Click Next to proceed with the installation. 

8. Progress details appear on the Setup Status screen.

9. The InstallShield Wizard Complete screen appears. Click Finish.

11-3 Installing the Mobile Client
To download the Mobile Client application to your device, download it directly from either the iTunes Store 
or Google Play onto your device. 
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11-4 Configuring a local IIS system for mobile 
connectivity

The Mobile IIS virtual pages are installed by default with the HP CR Server installation. No configuration is 
required if this system is local to the HP CR Server.

11-5 Installing a remote IIS system for mobile 
connectivity

In a process similar to installing the remote Intelligent Device Client, you must first install the Mobile Device 
client on the remote system, and then complete the configuration below. To set up a remote IIS system for 
Mobile connectivity:

1. Log in to the system using an account that belongs to the HP CR Administrators group.

2. Navigate to the network where the HP CR server setup files are located.

3. Run:

\MessageServer\setup.exe

The InstallShield wizard opens, configures your system, and displays the welcome message.

4. Click Next. The setup shows the License Agreement page.

5. Read the agreement and select I accept the terms of the license agreement option.

6. Click Next. The setup shows the installation options.

7. Select Custom and click Next. The setup shows a list of HP CR features.

8. Select the Intelligent Device Client and the Mobile Device API for installation and install them on 
the remote IIS server.

9. Click Next. The setup checks the system for installation requirements and displays the results.
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NOTE:  The setup cannot continue until all prerequisite components are installed. (Double-click an item in 
the list for more information.) If any required components are missing, click Cancel and exit the installation 
setup. Install the components, then install the HP CR Mobile Device API. 

10. Click Next. The setup shows installation settings.

11. Review the installation settings. Click Next to start the installation. The setup installs the selected 
component and displays a message indicating that the installation is complete.

12. Click Finish.

13. Continue to configure remote connectivity, as described below.

11-6 Configuring a remote IIS system for mobile 
connectivity

To allow connectivity between the Mobile Client and a remote IIS system:

1. Once the installation is complete, go to C:\Program Files 
(x86)\HP\HPCR\WebAPI\MobileWebAPI\Scripts, where you must open and modify the 
omISAPIU.xml file.

2. In the omISAPIU.xml file, you need to edit the server name from that of your remote IIS Server, 
which appears by default, to your HP CR server name.

For example, the default omISAPIU.xml file content includes:

</Server>

<Server Name="OmtoolServer">

<ServerName>REMOTE IIS Server name</ServerName>

</Server>

Change the text to the following:

</Server>

<Server Name="OmtoolServer">

<ServerName>HPCR Server Name</ServerName>

</Server>

3. For user access to the Mobile Device Client, connect to the HP CR server with the following login 
path: HTTPs://RemoteIISserverName/Mobile

11-7 Environment configuration to support HP CR 
Mobile Clients

Before you begin, you may want to create a secure connection for communications between Mobile Clients 
and your office environment. To do so, you need to modify the default IIS configuration from using HTTP 
to using HTTPS. For more information, see Configuring the Mobile Client environment to support HTTPS 
below.

To set up your system for incoming Mobile Reservations from an external source, you need to define a 
recipient for them in your email management system. You also need to be able to forward the messages 
to the HP CR server for processing.



HP CR Mobile Client

109

NOTE:  The steps outlined below use Microsoft Exchange as an example for configuring the email 
management system. Reference your email vendor’s documentation for more specific information.

The recipient email address you create needs to be associated with a user group in the HP CR Server 
Administrator. You also need to create an outbound rule to handle the messages from the Mobile Client. 

Once your system is configured, Mobile Client users can send a scanned message to the recipient email 
address using the Mobile Reservation Code as the subject line text.

To configure your environment, see:

 Configuring the Mobile Client environment to support HTTPS

 Configuring the email management system

 Configuring the HP CR server

11-7-1 Configuring the Mobile Client environment to support 
HTTPS

To create a secure connection between your office environment and Mobile Clients connecting from 
outside your LAN, you must modify the default IIS configuration from using HTTP to HTTPS.

Changing your configuration to HTTPS requires you to request, download and install an SSL certificate 
from a trusted Certificate Authority (CA). Refer to the CA you select for specific certificate installation 
instructions.

NOTE:  iOS devices include certificates from several trusted Root Certificate Authorities (CA). For a list of 
supported CA’s, go to http://support.apple.com/kb/ht5012.

The basic steps to acquire an SSL certificate are as follows:

1. Request your SSL Certificate from the CA.

2. Once your request is approved by the CA, you can download and install the certificate on your IIS 
web server. This enables Secure Socket Layer (SSL) for your IIS system.

3. To verify your installation, visit your website using HTTPS.

11-7-2 Configuring the email management system
In your email management system, use the steps below to

 define a recipient email address for Mobile Reservation scan messages, and

 forward those messages to the HP CR server for processing.

NOTE:  The steps outlined below use Microsoft Exchange as an example for configuring the email 
management system. Reference your email vendor’s documentation for more product-specific information.

1. Open the Exchange Management Console, and create a new Mail Contact from the Recipient 
Configuration section.

2. While entering information on the New Mail Contact page, be sure that when you enter the new 
contact’s External email address you assign it to the internal address of your HP CR server. For 
example: mobilescan@hpcrsrv.omtool.com


http://support.apple.com/kb/ht5012
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3. After you create the new Mail Contact, return to the contact Properties and add your email domain 
as a secondary email address. This allows it to be accessed from outside your organization. 
For example: mobilescan@omtool.com will now forward to 
mobilescan@hpcrsrv.omtool.com (the HP CR server).

11-7-3 Configuring the HP CR server
You can configure the HP CR Server for Mobile Reservations by associating the new recipient email 
address with specific user groups and creating an outbound rule to handle Mobile Reservation messages.

11-7-3-1 Group properties

To assign the new external email address to specific user groups:

1. Open the HP CR System Administrator and select Groups. 

2. Right-click the group of interest and select Properties.

3. In the Mobile tab, select Enable members of this group to use the mobile client.

4. Enter the external email address (created in step 2 of Configuring the email management system 
above) in the Scans to Email field and click OK.

11-7-3-2 Outbound rule

To create an outbound rule for handling Mobile Reservation messages:

1. Open the HP CR System Administrator, expand the Rules node and select Outbound.

2. Right-click Outbound and select New > Rule. The Create New Rule screen appears.

3. Click Add. The Add Rule Criteria screen appears.

4. Select Destination is an e-mail address and click Next.

5. In the Items to Match screen, select the is radio button and enter the External email address in 
the text box.

6. Click Add and then click Finish.

7. Returning to the Specify the Criteria for this Rule screen, click Next.

8. In the Specify actions to take for this Rule screen, click Add. The Add Rule Action screen 
appears.

9. Select Route to Embedded Directive Manager and click Next.

10. The Route to Embedded Directive Manager screen appears. Select Scan subject line for 
Reservation Code and click Finish.

11. Click Next, Next, and Finish.

NOTE:  See the HP CR administrator online help for optional server configuration for use with the HP CR 
Mobile Client.

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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12 HP CR for Microsoft SharePoint

HP CR enables Microsoft SharePoint users to import hardcopy documents into SharePoint libraries. The 
process is driven from the native SharePoint user interface using its screens and menus. HP CR can 
convert the scanned documents into text-searchable format (PDF or DOC), and then save the resulting 
document into the proper SharePoint library, fully profiled and stored alongside other electronic content. 
Once imported, you can browse through the document libraries to locate these documents, or use 
SharePoint enterprise search capabilities.

12-1 Microsoft SharePoint requirements
HP CR for Microsoft SharePoint can be installed on any of the following supported Microsoft SharePoint 
environments:

 Microsoft SharePoint Server 2013

 Microsoft SharePoint 2010

12-2 Installing HP CR for SharePoint client on the 
Microsoft SharePoint server

1. Log in to the Microsoft SharePoint Server system using an account that belongs to the 
Administrators group.

2. Navigate to the HP CR server system and find the following directory:

\\HP\Clients\Extensions for MS SharePoint

3. Run Setup.Exe. The setup configures your system and opens the InstallShield wizard showing 
the Welcome message.

4. Click Next. The Specify URLs page opens.

Enter the HP CR Client URL. This is usually:

http://HP CR Server Name}/WebClient

Enter the specific SharePoint site URL or sub-site URL. For example:

http://vmsharepoint201/sales

5. Click Next. The Ready to Install the Program page opens.

6. Click Install to begin the installation. When installation is complete, you will see the Installation 
Completed message.

7. Click Finish to close the InstallShield wizard.
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12-3 Configuration

12-3-1 Disabling the pop-up blocker in Internet Explorer
This required configuration will allow HP CR to access the SharePoint dialog. This procedure needs to be 
applied to each user’s system.

1. Open Internet Explorer (v7.0 minimum).

2. Select Tools from the menu bar.

3. Select the Turn Off Pop-Up Blocker option from the Pop-Up Blocker node.

12-3-2 Configuring the HP CR connector for Microsoft 
SharePoint

This required configuration is done from the HP CR server. All documents that are processed by the HP 
CR server are sent to Microsoft SharePoint via the HP CR Connector for MS SharePoint.

1. Click Start > All Programs > HP Capture and Route > HP Capture & Route Server 
Administrator.

2. Right-click Connectors and select New HP Capture and Route connector for > MS SharePoint.

3. The Server Address page appears. Run on the message server is the default choice. Click Next. 

Alternately, if you want the connector to run on a remote server, select Remote Server, enter the 
server name and click Next.

4. The Display Name page appears. In the Name text box, enter an appropriate name and click Next.

5. The Congratulations page appears. Click Finish.

6. The DMS Configuration page appears.

7. In the SharePoint Location text box, enter the location of the Microsoft SharePoint document 
library (for example: https://server/site/document_library).



HP CR for Microsoft SharePoint

115

NOTE:  If you are configuring your system with SharePoint 2013, an incorrect URL appears as the default 
SharePoint Location value. For example: http://omtoolltd.sharepoint.com/_layouts/15/
start.aspx#/Shared%20Documents.

You must edit the URL creating a pure directory path to, for the same example: http://
omtoolltd.sharepoint.com/Shared%20Documents

In this example, we removed /_layouts/15/start.aspx# from the path.

8. Select Connect using current user.

9. Click Finish to complete the DMS configuration.

12-3-3 Configuring full control permissions for members of the 
group

This can be run from any system that is logged in with SharePoint Administrator credentials.

1. Launch the SharePoint site in Internet Explorer.

2. Click the Site Actions drop-down and select the Site Settings option.

3. Select the People And Groups option in the Users and Permissions column.

4. Select the Home Owners option in the Groups section.

5. Click on New and select the Add Users option.

6. In the Under User/Groups field, add users and check for the required members.

7. Click OK to save your changes.

Full Control permissions are available to the selected members of the group.

12-3-4 Setting PDF documents to append date/time stamp for 
unique file name

By default, Routing Sheets should be set as single use, to avoid documents being overwritten. In some 
environments where PDF is used as the final format, the configuration.xml file can be modified to append 
a date/time stamp to the imported document creating a unique file name that will result in a new file added 
to the SharePoint.

1. On the SharePoint server, find the Configuration.xml and open it in Notepad:

C:\Program Files\Common Files\Microsoft Shared\Web Server 
Extensions\12|14\TEMPLATE\FEATURES\MessageServer

2. Locate the <Recipient Destination> tag of the configuration.xml file and REMOVE the 
following:

<prDMSDocumentUpdateOptions>1</prDMSDocumentUpdateOptions>

3. Find the <Recipient> tag of the configuration.xml file and add the following:

<prDMSDocumentUpdateOptions>4</prDMSDocumentUpdateOptions>

The values equal: 

4 = create new document

1 = overwrite document
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NOTE:  Only documents that are PDF final formats can have the date and time appended to the file name.
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13 HP CR for iManage Extensions

HP CR enables iManage users to import hardcopy documents into iManage libraries. The process is driven 
from the native iManage user interface using its screens and menus. HP CR can convert the scanned 
documents into text-searchable format (PDF or DOC), and then save the resulting document into the 
proper iManage library, fully profiled and stored alongside other electronic content. Once imported, you can 
browse through the document libraries to locate these documents, or use iManage enterprise search 
capabilities.

A user within the FileSite or DeskSite client interface can select an Import Scan option to specify profile 
information for the document that will be scanned later. When the document is scanned, it is uploaded to 
iManage in the target folder with the specified profile information. The scan can be accomplished using an 
HP MFP or other network-connected scanning device.

The Send to HP CR option also is available from FileSite or DeskSite. With this option, a user can extract 
one or more documents from the iManage repository and have these documents uploaded and attached 
to a new message composed using the HP CR Web Client.

13-1 iManage requirements
HP CR v1.5.0 support for iManage includes:

 FileSite v8.5 - v9.0

 DeskSite v8.5 - v9.0

13-2 Installing the iManage Extensions client on the 
DeskSite or FileSite client system

1. Log in to the system using an account that belongs to the Administrators group.

2. Navigate to the HP CR server system and find the following directory:

\\HP\HPCR\Clients\Extensions for iManage

3. Run Setup.Exe. The setup configures your system and opens the InstallShield wizard to the 
Welcome message.

4. Click Next. The Web Client URL screen opens.

In the Enter Web Client URL field, enter the Server name. For example:

http://[ServerName]/HPCR

5. Click Next. The Destination Folder screen opens. Optionally, you can change the Destination 
Folder’s location. 

6. Click Next. The Ready to Install the Program screen opens.

7. Click Install to begin the installation. When installation is complete, the Installation Completed 
message appears.

8. Click Finish to close the InstallShield wizard.
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13-3 Setting up end user extensions
This required configuration is done from the HP CR server. All documents that are processed by the HP 
CR server are sent to iManage via the iManage (DMS) connector.

1. In the HP CR Server Administrator, right-click on the Connectors node and select New HP Capture 
and Route connector > WorkSite. The Create New WorkSite DMS Connector screen appears.

2. Select the Run on the Message Server option or specify a remote server.

3. Click Next. On the Display Name screen, enter a name for the connector and click Next.
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4. On the Congratulations page, click Finish to create the connector. The WorkSite Login 
Configuration screen appears.

5. Enter a WorkSite Server.

6. Enter the user name and password for a Specific User.
Or, select the Use Trusted Login option.

7. Click Next. The WorkSite Configuration page appears.

8. Select options for the Login configuration and Profile type.
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9. Select the Placeholder option if you want to retain placeholder profiles in iManage after creating an 
Embedded Directive.

10. Click Next. The Interwoven Records Manager screen appears.

11. Select whether or not you want to declare new profiled items as Records and integrate with 
Interwoven Records Manager.

12. Click Finish to complete the configuration.
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14 HP CR Server Monitor

HP CR Server Monitor is a stand-alone application that monitors various components of an HP CR server. 
It executes custom-created tests to detect workflow bottlenecks and system failures. 

Conditions that can be monitored include the message database size, available disk space on the HP CR 
server, Send and Receive folder sizes, HP CR services status, and connectors status. Additionally, with its 
versatile monitoring capabilities, HP CR Server Monitor runs test in specified frequencies; maintains a 
suspend schedule; supports custom actions for each test which can include sending e-mail notifications, 
writing entries to the event log, and changing the status of HP CR services; supports custom email 
addresses for the source and destination of notification messages; and monitors HP CR server clusters.

HP CR Server Monitor consists of:

 HP CR Server Monitor Administrator - A snap-in to the Microsoft Management Console, the 
Administrator plays two essential roles. First, it serves as the user interface where you create “tests” 
for each HP CR server you monitor. (Each test consists of criteria and at least one action.) Second, 
the Administrator connects to the HP CR Server Monitor Service. Because the HP CR Server 
Monitor Administrator can run on a different system than the HP CR Server Monitor Service, you can 
manage your server monitoring methods from another Windows system in the local area network, 
including your desktop.

 HP CR Server Monitor Service - This Windows service performs all monitoring activities from a 
high-availability server. It logs on to the HP CR server using the HP CR server account, which has 
DCOM access and launch permissions on the HP CR server, and then executes the tests created in 
the Administrator.

This section provides details on installing and using HP CR Server Monitor, an application that monitors 
the HP CR server environment. This information is written for an advanced computer user or network 
administrator with working knowledge of the HP CR server environment.

Requirements (121)

Installing HP CR Server Monitor (122)

Required configuration (123)

For additional information (including optional configuration and troubleshooting), refer to the HP CR 
administrator online help.

14-1 Requirements

14-1-1 HP CR Server Monitor service requirements
The system where the HP CR Server Monitor Service is installed must meet these minimum requirements:

 Windows NT domain computer that always runs in the same domain as the HP CR server and is not 
a domain controller, an HP CR server, or a remote server

 Pentium III-compatible processor, 1 GHz, 512 MB RAM, 20 GB available hard disk space, CD-ROM 
drive, and Microsoft mouse or compatible pointing device

 Windows 2012 (64-bit), Windows 2008 (64-bit)

 IIS configured for SMTP mail delivery

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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14-1-2 HP CR Server Monitor Administrator requirements
The system where HP CR Server Monitor Administrator is installed must meet the following minimum 
requirements:

 Windows NT domain computer that belongs to the same domain as the HP CR server

 Pentium III-compatible processor, 1 GHz, 512 MB RAM, 200 MB hard disk space, CD-ROM drive, 
and Microsoft mouse or compatible pointing device

 Windows 2012, Windows 2008 R2

14-1-3 Additional installation requirements
HP CR Server Monitor also requires the following:

 HP CR service account or another account that belongs to the HP CR Admins group on the HP CR 
server

14-2 Installing HP CR Server Monitor
HP CR Server Monitor is installed with two components: HP CR Server Monitor Administrator and HP CR 
Server Monitor service. The HP CR Server Monitor service, a Windows service that monitors the HP CR 
server environment, is installed on one system only. The HP CR Server Monitor Administrator can be 
installed multiple systems so that one or more administrators can conveniently manage HP CR Server 
Monitor.

TIP:  HP CR Server Monitor Administrator and HP CR Server Administrator are snap-ins to the Microsoft 
Management Console. Both snap-ins are supported on the same system so that administrators can 
manage the HP CR server and the application that monitors it from the same location.

The HP CR Server Monitor setup files are installed on the HP CR server in a folder that is not shared by 
default. Before installing HP CR Server Monitor, log on to the HP CR server using an account that belongs 
to the local Administrators group, share 
C:\Program Files (x86)\HP\HPCR\Tools\ServerMonitor
and give the HP CR Server Monitor installation user read access to the share.

To install HP CR Server Monitor:

1. Log on to the system where HP CR Server Monitor is being installed using an account that belong to 
the local Administrators group:

C:\Program Files (x86)\HP\HPCR\Tools\ServerMonitor

Copy the setup files to the system where HP CR Server Monitor is being installed.

2. Run setup.exe. The setup starts and displays a welcome message.

3. Click Next. The setup shows the license agreement.

4. Read the license agreement and click Yes if you agree to the terms. The setup shows setup options.

5. Click Next. The setup requests logon credentials for the HP CR Server Monitor Service.

NOTE:  To install only the HP CR Server Monitor Administrator, select Custom. Clear Server Monitor 
Service and click Next. Go to step 7.
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6. Enter the logon credentials of the HP CR service account or another account that belongs to the HP 
CR Admins group on the HP CR server, and click Next. The setup shows installation settings.

7. Review the installation settings and click Next to begin the installation. The setup shows a message 
indicating that the installation is complete.

8. Click Finish.

14-3 Required configuration

14-3-1 Configuring HP CR connectors for Filescan and Telco
HP CR Server Monitor can run tests on folders associated with HP CR connectors for Filescan and Telco. 
In order to run tests on these folders, the folders must be configured in UNC format. (UNC uses the format 
\\computer\folder. Drive letter mappings, such as G:\folder\folder, are not supported.) If an HP 
CR server has either of these connectors, complete the required configuration in this section.

NOTE:  If you configure HP CR Server Monitor to run tests on a folder, verify that the Windows user 
account associated with the HP CR Server Monitor Service has sharing permissions on that folder and 
security permissions with read access.
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14-3-1-1 Configuring the Filescan connector folders with UNC paths

1. Click Connectors in the console tree and double-click the Filescan connector in the details pane.

2. Click the Folders tab.

3. Verify that each folder has been configured with a UNC path. (If you need to change a folder 
configuration, select the folder and click Properties. Type the UNC path to the folder in the Folder to 
scan field and click OK.) 

4. Click OK to save your changes to the connector.
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14-3-1-2 Configuring the Telco connector with a UNC path

1. Click Connectors in the console tree and double-click the Telco connector in the details pane.

2. Click Advanced on the General tab.

3. Verify that the path to the Telco share directory is in UNC format. Change it if necessary, and then 
click OK. 

4. Click OK to save your changes to the connector. 
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14-3-2 Configuring HP CR server properties
After you add an HP CR server to the HP CR Server Monitor Administrator, right-click the server (or, 
highlight the server and click Action on the toolbar) to open the available options menu.

The available options are:

 Properties - Select this menu item to configure options on the General and Suspend Monitor tabs.

 Remove - Select this menu item to remove the server from the HP CR Server Monitor Administrator.

 New - Select this menu item to create a new test.

Figure 14-1 HP CR Server Monitor Properties

14-3-3 Clustering
When adding a clustered server to the HP CR Server Monitor Administrator, it must be active. The server 
icon in the HP CR Server Monitor Administrator changes when you add a clustered server.

If you are using a clustered server environment, please consider the following while configuring HP CR 
Server Monitor:

 You need to cluster a server before you add it to the HP CR Server Monitor Administrator.

 Make sure you add the preferred server in the cluster to the HP CR Server Monitor Administrator.

 If the failover time in a clustered environment exceeds 90 seconds, HP CR Server Monitor performs 
all actions specified in the Cluster Failover Action option located on the server properties General 
tab. It also performs all these actions if both the preferred and secondary servers are shut down.

 After control is moved from the preferred server to the secondary server, the test will be performed 
for the backup server, but the stored configurations are not updated with the backup server name.
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14-3-4 Defining sender and recipient email addresses
When you add a server to the HP CR Server Monitor Administrator, you are prompted to enter two email 
addresses in the Default Test Criteria screen.

Figure 14-2 Default Test Criteria screen

The email address in the From field is used as the default sender's email address whenever you add a 
new email action for your test criteria.

The email address in the To field is used as the default recipient's email address whenever you add a new 
email action for your test criteria.

NOTE:  The From and To email addresses are also used for email notifications of critical errors in a 
clustered environment.

TIP:  You can enter multiple email addresses in the To field by separating each email address with a 
semicolon (;), or you can enter a distribution list address. Distribution list aliases are not supported.

You can update the email addresses in the server properties at any time, as well as override the default 
email addresses when creating new test criteria.

14-3-5 Defining server properties: The General tab
The General tab is where you define server properties in the HP CR Server Monitor.

14-3-5-1 Opening the General tab

Right-click the server and select Properties. (Or, highlight the server, click Action on the toolbar, and 
select Properties.) The General tab is selected by default.

On this tab, you can:

 Enable or disable monitoring of this server by selecting or clearing Enable monitoring of this 
server. The icon displayed in the HP CR Server Monitor Administrator changes based on your 
selection.

 Change the sender and recipient email addresses. You defined these email addresses when you 
added the server to the HP CR Server Monitor Administrator.

 Define actions for when a failover occurs.
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TIP:  You can enter multiple email addresses in the To field by separating each email address with a 
semicolon (;), or you can enter a distribution list address. Distribution list aliases are not supported.

14-3-5-2 Defining failover actions

In a clustered environment, you can define the actions that happen when a failover event occurs in the 
cluster. For example, you can define a Failover Action that sends an email if the secondary server takes 
over from the preferred server.

1. Click Failover Action on the Server Properties General tab. The Cluster Failover Action screen 
appears.

2. Specify the actions to take when a failover occurs.

Complete the wizard for the action you specified.

14-3-6 Optional configuration
For additional, optional configuration procedures, refer to the HP CR administrator online help.

 

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
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15 Setting up an HP CR Server Cluster

This section describes the following:

Introduction to Failover (131)

Requirements for an HP CR server cluster (133)

Installing and configuring the cluster server (134)

Setting up the Database server (134)

Setting up the Active server (135)

Applying licenses (138)

Setting up the Passive server (139)

Setting up the Telco share (141)

Creating the Telco share (141)

Configuring the HP CR connector for Telco to use the Telco share on the Database server (141)

Testing the failover configuration (142)

Optional configurations for cluster environments (143)

15-1 Introduction to Failover
Automatic failover, a native HP CR capability, ensures seamless and immediate recovery from a localized 
system failure on the HP CR server. It requires two redundant HP CR servers that are joined to form an 
HP CR server cluster, and a third system where critical server resources are stored.

The redundant HP CR servers are referred to as:

 Active server - the current HP CR server

 Passive server - the standby server

The third system that stores critical resources is called the “Database server” because it hosts the server 
databases along with server configuration files. If the HP CR server is enabled for faxing, the Database 
server also hosts the Telco share, which is an intermediary repository for inbound and outbound faxes. 
(The Database server can also function as a remote server such as remote administrator, remote 
composer, or remote modem server.)

In some environments, where multi-function devices are used, a fourth system - Remote IIS - can be added 
to host the HP CR Intelligent Device client and specific HP CR device client installs. 

Failover is driven by the HP Cluster Service which is installed on the HP CR server. (This service does not 
appear in the Services applet because it is not registered by default.) When an HP CR server cluster is 
created, this service is immediately registered and runs simultaneously on both HP CR servers in the 
cluster. During regular operation, the active server in the HP CR server cluster continuously writes to the 
server databases while HP Cluster Service on the passive server polls the Database server in 45-second 
intervals to verify that the active server remains active.
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When a localized system failure occurs on the active server, it loses communication with the Database 
server and cannot write to the server databases. As soon as the HP Cluster Service on the passive server 
polls the Database server again and finds no recent activity from the active server, the HP Cluster Service 
on the passive server starts all its local HP CR services and becomes the active server in the cluster. The 
transition is complete within 1 to 3 minutes of the failure.

Figure 15-1 HP CR server cluster basic setup

An HP CR server cluster has two redundant 

HP CR servers referred to as the active 

server and passive server, and a third 

system that stores critical HP CR server 

resources called the database server.
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Figure 15-2 HP CR server cluster in failover mode

An HP CR server cluster enters failover 
mode when a localized system failure 
causes the current HP CR server to go 
offline and the other server to become 
active.

After a failure occurs, an administrator needs to restore the server that is offline. 

TIP:  HP CR Server Monitor is a monitoring application that detects failures on HP CR servers. It is 
recommended that HP CR Server Monitor or another monitoring application be used to alert administrators 
that a failure has occurred so that failures can be corrected in a timely manner.

An HP CR server in the cluster can be designated as the preferred server. If an HP CR server is preferred, 
it is always the active server whenever it is available. Therefore, if a system failure occurs and the preferred 
server goes offline, the non-preferred server becomes active, but when the preferred server is online again, 
it becomes the active server and the non-preferred server returns to a standby state.

15-2 Requirements for an HP CR server cluster

15-2-1 HP CR server requirements
The two HP CR servers must meet the minimum requirements for an HP CR server. For details, see 
Hardware and software requirements (7).

NOTE:  The HP CR servers should have identical and redundant configurations. If resources are shared, 
for example, a remote Composer, the shared resource should be installed on the database server or 
another high availability system in the domain.
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15-2-2 Database server requirements
The database server must meet the following minimum requirements:

 Hardware and software requirements (7) for the HP CR server

 Microsoft SQL Server 2008/2012

NOTE:  Microsoft SQL Server 2008 Express Edition does not meet this requirement.

 Template files used by the server

15-2-3 Remote device server requirements
The Remote Device server must meet the following minimum requirements:

 Requirements for the Remote Device server, as defined in Installing the Remote HP CR Intelligent 
Device Client (69)

15-3 Installing and configuring the cluster server
Begin setting up the Server Cluster by creating folders for the HP CR server resources that will be stored 
on the Database server.

15-3-1 Setting up the Database server
1. Select a location in the Database server. 

2. Create the following folders:

 Messages - Stores the message database.

 Config - Stores server configuration files.

3. Share each folder.

4. Give the HP CR service account read, write, and delete permissions to each folder. For more 
information on modifying permissions, consult Windows help.
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15-3-2 Setting up the Active server
1. Install HP CR v1.5.0 on the Primary server. For installation steps, see Installing the HP CR server.

2. On the InstallShield Wizard Complete screen (the last installation screen), click 
Finish to complete the installation. 

3. The HP CR Configuration Wizard automatically launches next. 

Select Failover cluster configuration.
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4. On the Cluster Server Role screen, select Active server member and click Next. 

5. On the Database screen, select the appropriate database option: 

 Create a new database – for configuring a new installation of HP CR.

 Use an existing database – for upgrading an existing installation of HP CR.
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6. Click Next. The Create New Database screen opens. 

Enter your SQL Server and Database Name information and click Next.

7. At the File Share Location field on the File Share screen, enter or browse to the UNC path you 
want to use. (This is a path to the folder location you created in Step 1.) Click Next. 

8. The Ready to Configure screen appears. Click Next to configure the system. 
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A Configuring... progress screen appears during configuration.

9. The Server Configuration Wizard Welcome screen opens. Click Next. 

10. Click Finish on the Congratulations screen.

11. The following screen shows how the Primary server appears in the HP CR Server Administrator.

15-3-3 Applying licenses
12. Apply your Base server and Failover licenses. See Server license activation for more information.

NOTE:  The Failover server license is added to the Active (Primary) server in the environment.
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15-3-4 Setting up the Passive server
13. Install HP CR v1.5.0 on the Passive (secondary) server. For steps, see Installing the HP CR server.

14. On the InstallShield Wizard Complete screen (the last installation screen), click Finish to complete 
the installation.

15. Once again, the HP CR Configuration Wizard opens to the Welcome screen. Select Failover 
cluster configuration. 

16. On the Cluster Server Role screen, this time select Passive server member and click Next. 



Setting up an HP CR Server Cluster

140

17. The Setup Cluster screen appears. 

Enter the Primary Server name and user information. Click Next.

18. The Ready to configure screen appears. Click Next to configure the system. 

A Configuring... progress screen appears during configuration.
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19. The HP CR Configuration Wizard Completed screen appears. 

Click Finish to close the wizard. Your clustered server environment is now configured.

15-4 Setting up the Telco share

15-4-1 Creating the Telco share

NOTE:  Complete the following procedure if the HP CR server cluster supports faxing.

For an HP CR server cluster that supports faxing, create the Telco share. The Telco share is shared by 
both servers in the cluster. You must create it on any high-availability system, such as the Database server 
belonging to the same domain as the clustered HP CR servers.

To create the Telco share on the Database server:

1. Choose a location in the local directory structure and create a folder for the Telco share. Use a self-
descriptive name such as HPtelcoshare.

2. Share the folder.

3. Give the HP CR service account read and write permissions to the folder. For more information on 
modifying permissions, consult Windows help. (If the environment has HP CR servers that were 
installed with different HP CR service accounts, give all HP CR service accounts these permissions.)

15-4-2 Configuring the HP CR connector for Telco to use the 
Telco share on the Database server

1. Click Start > All Programs > HP Capture and Route > HP Capture & Route Server 
Administrator to open the HP CR Server Administrator. 

2. In the console tree, expand the HP CR Server Administrator and click Connectors.

3. Double-click HP CR Connector for Telco in the details pane to open the Telco Properties page.
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4. Click Advanced to open the Telco Advanced Properties page. 

5. In the Path to telco share directory text box, enter the UNC path (that is the 
\\ServerName\ShareName)\ to the Telco share folder. Add a trailing backslash at the end (for 
example: \\123.4.5.678\HPtelcoshare\). 

6. Click OK twice to save your changes and close the Properties page. 

15-5 Testing the failover configuration
You can test the Failover configuration by simulating a localized system failure on the Active server:

1. Simulate a failure - Shut down the Active server. Wait approximately five minutes and then verify 
that the HP Cluster Service process (OMSvrClusterMgr) and the connector processes (OmCon*) are 
running on the other server, which is now the Active server.

2. Restore the failed server - Start the server that was shut down and wait for it to boot up. Wait 
approximately five minutes and then verify that the HP Cluster Service process (OMSvrClusterMgr) 
and the connector processes (OmCon*) are running.
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15-6 Optional configurations for cluster 
environments

15-6-1 Setting up the remote device server
Refer to the procedure for Installing the Remote HP CR Intelligent Device Client (69).

15-6-2 Configuring the HP CR Legacy End User Interface for 
failover

The Legacy End User Interface should be installed on a system remote from the Active and Passive 
servers and meet all of the installation requirements.

1. Navigate to:

\Program Files (X86)\HPCR\WebClient\Configuration

Open the Web.xml file for editing.

2. In the <Connection> section of the xml, add the name of the secondary server in your cluster. For 
example:

<Connection>

<Server>MAGNOLIA</Server>

<FailoverServer>JASMINE</FailoverServer>

<Authentication type=”Exchange”>

NOTE:  In this example, the name of the active HP CR server is MAGNOLIA and the passive server is 
JASMINE.

3. Save your changes and close the xml file.

4. Restart the IIS services.

15-6-3 Configuring the Mobile Client setup to support a cluster
To configure cluster support for a setup with mobile clients:

1. Modify the OmISAPU.xml in the \Omtool\Omtool Server\WebAPI\MobileWebAPI\Scripts 
directory as follows:

2. Add another line for the secondary server, changing

</Server>

<Server Name="OmtoolServer">

 <ServerName>VMOXPTESTING</ServerName>

</Server>

</Servers>

to the following:

</Server>

<Server Name="OmtoolServer">
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<ServerName>VMPrimary</ServerName>

<Server Name="OmtoolServer"> 

<ServerName>VMSecondary</ServerName>

</Server>

</Servers>

15-6-4 Clustering and Composer thread awareness
In a typical configuration, you use the local Composer on the Active server while the Passive server is in 
the waiting state. To improve throughput, an additional compose license can be added to access the 
compose engines on the passive server. However in the event of a failover, both the local and remote 
Composers would be on the same physical machine, and using them simultaneously can cause significant 
performance issues on the passive server. In order to utilize both servers, the Active server compose 
should be removed and reinstalled with the server name specified. The Passive server then can be added 
with its server name specified and, in the subsequent event of a failover, the Passive server will not be 
subject to performance issues due to duplicate composers.
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16 Installing and configuring a Dialogic modem 
driver

This section contains instructions on installing and configuring the following Dialogic modem driver. It is 
written for system administrators with detailed knowledge of the HP CR server and the following modem 
driver.

SR140 module (virtual board)
For information on BrookTrout T.38 SR140, go to the BrookTrout online documentation.

Each subsection details the procedure involved in installing and configuring the modem driver. This section 
also provides information for Testing (150).

16-1 Requirements for installing and configuring the 
SR140 module

16-1-1 HP CR software requirements

 HP CR v1.5.0 or higher

 Telco connector (to configure the HP CR message server for faxing messages)

16-1-2 Driver requirement

 Brooktrout v6.7.5 or higher 

16-1-3 Gateway requirement
For a list of supported gateways, go to the BrookTrout online documentation.

16-1-4 Additional requirements
In addition to meeting the requirements listed above, you need the following: 

 Proper T1 fax card on the gateway

 Enough memory to run the necessary amount of channels

16-2 Installing the BrookTrout SR140 module

16-2-1 Installing Brooktrout v6.7.5 drivers
1. Verify that the HP CR Modem Manager service is not running.

2. Go to the location where you extracted the ZIP file and locate the HP CR directory. 

http://www.cantata.com/interop/fax/
http://www.cantata.com/products/sr140/pdf/SR140.pdf
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3. Double-click Boston6.7.5.msi. The Welcome page opens. 

4. Click Next. The License Agreement page opens. 

5. Read the license agreement and, if you agree, select I accept the terms in the license agreement.

6. Click Next. The Destination Folder page opens.

7. Change the destination location if necessary and click Next.

8. Click Install.

9. When installation is complete, click Finish.

10. Reboot the server.

16-2-2 Installing 6.7.5_x64.msi
1. After you finish installing the Brooktrout System Software, install the required add-on, Brooktrout 

6.7.5_x64.msi.

2. Verify that the Model Manager service is not running.

3. Go to the location where you extracted the ZIP file and locate the HP CR 64 directory.

4. Double-click Boston6.7.5_x64.msi. The Welcome page opens. 

5. Click Next. The License Agreement page opens. 

6. Read the license agreement and, if you agree, select I accept the terms in the license agreement.

7. Click Next. The Destination Folder page opens.

8. Modify the destination location if necessary and click Next.

9. Click Install.

10. When installation is complete, click Finish.

11. Reboot the server.

16-2-3 Activating the license
1. Click Start >Program Files > Brooktrout License Manager. 

The BrookTrout License Manager opens.

2. In the menu bar click License >Activate License. The License Activation wizard opens and you 
see the Welcome message.
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3. Click Next. Select Using the interactive web method. 

4. Click Next. You get the Node Lock value. 

5. Click the Save the instructions into a file option.

6. Click Next. 

7. Browse and save the file to a known location. 

8. Go to the location where you saved the file. Open the file. 

The file contains the text similar to what is shown below and gives you the Node Lock value of your 
system:

To request a license, please visit our website:
http://www.dialogic.com/activation
and follow the instructions provided on the website.
Dialogic will email the license to you immediately.
When prompted, supply the following information:
Node Lock: [Node Lock value]

9. Open Internet Explorer and go to http://www.dialogic.com/activation.
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10. In the License Key text box, enter the License key and the Node Lock value of your system. 

IMPORTANT:  For the license key, contact your software representative. 

Brooktrout sends you the license for your BrookTrout SR140 module.

NOTE:  This license key will enable the Brooktrout SR140 fax feature on the system the node value was 
retrieved from. It cannot be transferred without assistance from Cantata.

11. Save the license file to the local drive of the system. 

16-2-4 Applying the license
1. Launch the Brooktrout License Manager.

2. From the file menu option, select License. 

3. Select the Install License drop-down.

4. Browse to the license file you saved to the system.

16-3 Configuring Brooktrout SR140
1. Click Start > Program Files > BrookTrout Configuration Tool. 

The Configure IP Stack page opens. 

2. Select the protocol appropriate to your environment. 

The BrookTrout Configurations Tool opens.

3. Expand Call Control Parameters. 

4. Select Module0x41:SR140. 

5. In the right pane, click the Parameters option.

6. Verify that the IP Call Control Module value is SIP or H.323 (depending on which protocol is 
configured for your company).
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7. Continue to Additional SIP configuration (149) or Additional H.323 configuration (149). You can 
configure SIP or H.323, but not both. 

16-3-1 Additional SIP configuration
1. Click Start > Program Files > BrookTrout Configuration Tool. 

The BrookTrout Configurations Tool opens.

2. Expand IP Call Control Modules. 

3. Select SIP. 

4. In the right pane, select the IP Parameters option.

5. In the SIP_default_gateway add the IP address of your Cisco Gate followed by 5060 in the second 
field.

6. Select the T.38 parameters option.

7. Set Media Renegotiate Delay Outbound, msec to -1.

8. In Advanced settings, change the Maximum T.38 version from 3 to 0.

9. The prompt Parameter Maximum Bit Rate, bps value should not be greater than 14400 when 
Maximum T.38 version is 0 is displayed.

10. Click OK and the Maximum bit rate,bps is automatically reset to 14400.

16-3-2 Additional H.323 configuration
1. Click Start > Program Files > BrookTrout Configuration Tool. 

The BrookTrout Configurations Tool opens.

2. Expand IP Call Control Modules. 

3. Select H.323. 

4. In the right pane, select IP Parameters option.

5. Add the IP address of your Cisco Gateway in the h323_default_gateway followed by 1720.

6. Add the IP address of your HP CR server in the h323_local_ip_address followed by 1720.

7. Expand Advanced Settings option. 

8. Change Called Party Options to 2.

9. Change Calling Party Options to 2.
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16-3-3 Setting the maximum page size
Brooktrout modems have a known problem with sending document with greater than 30 pages. You must 
change the Maximum Number of Pages property value to 200 in order to send messages greater than 
30 pages successfully. 

1. Click Start > All Programs > BrookTrout > Brooktrout Configuration Tool. 

2. Select BTCall Parameters (All boards).

3. In the Advanced Settings section, go to the Maximum Number of pages option.

4. Set the value to 200.

5. Save your changes. 

6. Click Apply to make the Brooktrout server read your changes. 

16-4 Testing
After you have installed and configured the modem drivers, test to see that the Dialogic fax board/module 
are working properly.

1. Stop Modem Manager Service. 

2. Login to the system running the modem server.

3. Navigate to:

C:\Program Files (x86)\HP\HPCR\Tools\Modem\Tools\BrookTrout\Config

4. Copy fax.exe and test.ips.

5. Paste the copied files to:

C:\Program Files\Brooktrout\Config

6. To send a test fax:

a Open a command prompt window.

b Change directory to:
C:\Program Files\Brooktrout\Config.

c Type:
..\bin\firmload.bat
Press Enter.

d Type:
fax -u 0 -s PhoneNumber test.ips
where PhoneNumber is the destination fax number.

Press Enter.

The test fax is delivered to the destination.
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17 Software integrations

HP CR integrates with software provided by several third-party vendors:

Multi-vendor device configuration (153)

HP Access Control (157)

HP iManage TeleForm (158)

Each is described in this section.

17-1 Multi-vendor device configuration
HP CR features are accessible where the users need them most—on the web, office machines, 
multifunction devices, and business systems that are an integral part of the communication workflow. 

HP CR is an intranet-based application for multifunction devices and business systems. HP CR supports 
software solutions complementing the hardware solutions offered by Hewlett Packard as well as 
integrating with other vendor devices such as Ricoh Corporation, Sharp Electronics Corporation, and 
Xerox Corporation.

Procedures for multi-vendor device testing are provided in this section.

NOTE:  For Embedded Device Client for HP OXPd download, installation, and configuration instructions, 
refer to the HP Capture and Route (HP CR) Embedded Device Client Installation Guide.

17-1-1 Ricoh

NOTE:  When scanning from Ricoh devices, users must choose Multi-paged PDF in the scan options of 
the device.

17-1-2 Sharp: Address registration with the Sharp MX-C311
1. Set up FTP Role Service on the destination server (HPCR).

2. Once the FTP service is installed, create an FTP site in IIS. Review the information at this link if you 
are not familiar with creating an FTP site:

http://learn.iis.net/page.aspx/301/creating-a-new-ftp-site-in-iis-7/

3. When creating the site, the physical path will be the Filescan directory.

4. Select No SSL.

5. Allow Anonymous and Basic Authentication with Read and Write Permissions.

6. Set up the Filescan directory in virtual mode and add a virtual control file.

7. Open the Embedded Web Server on the Sharp device.

8. Log in and click Address Book.

http://learn.iis.net/page.aspx/301/creating-a-new-ftp-site-in-iis-7/
http://www.omtool.com/documentation/hpcr/1.4.0/hpcrembeddeddeviceclient.pdf
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9. Click Add.
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10. Select FTP as the Address Type.

11. Enter an address name in the Address Name (Required) field.

12. Enter the IP address of the HPCR server in the Hostname or IP Address (Required) field.

13. Enter the FTP root (\) for the Directory.

14. Add the User Name credentials and Password.

15. Click Submit.

16. On the device, select Image Send\Address Book.

17. Locate the address and scan a job.

18. The file will be scanned to the Filescan folder on the HPCR server.
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17-1-3 Xerox: Creating a new workflow template with the 
Xerox WorkCentre 6400

1. Set up FTP Role Service on the destination server (HP CR).

2. Once the FTP service is installed, create an FTP site in IIS. Review the information at this link if you 
are not familiar with creating an FTP site:

http://learn.iis.net/page.aspx/301/creating-a-new-ftp-site-in-iis-7/

3. When creating the site, the physical path will be the Filescan directory.

4. Select No SSL.

5. Allow Anonymous and Basic Authentication with Read and Write Permissions.

6. Set up the Filescan directory in virtual mode and add a virtual control file.

7. Open the Embedded Web Server for the device and log in.

8. Click the Scan tab.

9. Click Templates in the Display section.

10. Enter a name in Template Name.

11. Select the Enter a Scan Destination radio button.

12. Enter a friendly Name.

13. Select FTP for the Protocol.

14. Select IPv4 Address for the Name or IP Address.

 

http://learn.iis.net/page.aspx/301/creating-a-new-ftp-site-in-iis-7/
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15. Enter the IP address and port.

The following is an example:

17-2 HP Access Control
The integrated HP CR and HP Access Control (HP AC) solution provides for:

 “Advanced” single-sign between HP AC and HP CR. This includes the ability for HP AC to capture a 
user’s network password and then securely transfer that password to HP CR. From that point, HP 
CR could use the name and password of the logged in user to upload documents to SharePoint or 
store documents in a network folder as that user.

 Transfer of job accounting details from HP CR to HP AC. The following job accounting details on 
each job processed through HP CR are captured and made available for import into the HP AC 
system:

 Master Job ID

 Source scanning device or fax channel, if known

 Source originating user, if known
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 Date/time of submission for processing

 Date/time of completion of processing

 Final delivery status (success, failure, reason for failure if applicable)

 Size of documents submitted, delivered, expressed in pages

 Size of documents submitted, delivered, expressed in bytes

 Delivery destination type (for example, fax, email, folder, SharePoint, etc.), delivery address 
(such as 1-800-555-1212, user@company.com, etc.)

Any individual job may be delivered to multiple individual recipients. A separate job tracking record is 
captured and transferred for each recipient. All deliveries for a single, submitted job share a common 
master job ID.

It is not necessary for the HP CR and HP AC servers to install and run together on the same Windows 
server.

17-3 HP iManage TeleForm
HP iManage TeleForm is a software-based solution for document capture used to extract and validate 
information from complex, forms-related documents. HP CR integrates with TeleForm so that documents 
captured through HP CR can be transferred to TeleForm for processing. HP CR also has the ability to 
receive documents and metadata sent to HP CR from TeleForm so that HP CR can deliver the content to 
one or more intended destinations.

17-3-1 Configuring the HP CR server
The Universal Input and Universal Output connectors enable HP CR to support integration with HP 
iManage TeleForm. HP CR integrates with TeleForm so that documents captured through HP CR can be 
transferred to TeleForm for processing. HP CR can also receive documents and metadata sent from 
TeleForm and deliver the content to one or more intended destinations.

HP CR and TeleForm integration use:

 HP CR’s Universal Input connector to receive documents and metadata which have been exported 
from TeleForm. An XSLT translation parses the XML sent back from TeleForm and maps this 
information to appropriate Job Properties created on the HP CR server. HP CR then processes the 
returned job based on these properties and routes it to its intended destination(s).

 HP CR’s Universal Output connector to output scanned documents and metadata to a target 
network folder, which is monitored by TeleForm as a source for incoming documents to process. The 
Universal Output connector stores a scanned document as well as an XML file, which may include 
metadata regarding the scanned document. The Universal Output connector is configured to use an 
XSLT, which formats the output metadata from the HP CR server in a documented format that can 
be parsed and imported to TeleForm.

The remainder of this section describes:

Enabling HP CR Universal Output (159)

Enabling HP CR Universal Input (169)
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17-3-2 Enabling HP CR Universal Output

17-3-2-1 Configuring the Universal Output connector

The HP CR server installation includes a Universal Output connector (Universal Output on the Server) 
by default. This connector is automatically configured during installation. However, some connector 
properties can be changed as needed. To access and configure the connector:

1. Click Start > All Programs > HP Capture and Route > HP Capture & Route Server 
Administrator.

2. In the console tree, expand the HP CR server.

3. Select Connectors. The results node lists the connectors that are licensed with your server.

4. Double-click the Universal Output connector to view its properties. Click the XSLT tab.

The following fields contain default values. These values can be changed as needed.

a XSLT file – the XSL translation file used to format XML files

b Output Folder – the monitored folder for images and XML files

c Translated File Extension – the default value is xml

5. At Multiple attachment handling, select either:

 Create an XML output for each attachment, individually

 Create an XML output that references all attachments

6. At Store Attachments, select either

 In output folder

 In translated file as, and select a file type from the dropdown menu.

7. Click OK to save the settings and close the Properties for Universal Output on the Server page.
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17-3-2-2 Creating a rule for HP CR

HP CR can pass a job to TeleForm based on certain criteria. This can be the sender’s email address, the 
destination, or various other options. For this example, assume that anything going to the email address 
destination TeleForm@hpcr.com should be forwarded to the TeleForm server. You would follow these 
steps:

1. Click Start > All Programs > HP Capture and Route > HP Capture & Route Server 
Administrator to open the HP CR Server Administrator.

2. In the console tree, expand the HP CR server.

3. Expand Rules > Outbound.

4. Right-click to choose a new rule.

5. Click Add.

6. Select Destination is an e-mail address.

7. Click is.

8. Enter:

TeleForm@hpcr.com

9. Click Add.

10. Click Finish.

11. Click Next.

12. Click Add.

13. Select Route to Connector.
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14. Click Next. The Route to Connector page is displayed.

15. From the Route to Connector, select Universal Output on the Server.

16. Set the Document Delivery Format to PDF.

17. Be sure Include Template is not selected.

18. Click Advanced.

19. Click Set Additional Job Properties...

20. In Set Job Properties, click Add... and select a User Property from the dropdown menu, for 
example, prDMSUseDefaultProfile.

21. For the Value, enter 1.

22. Click OK to close the Set Job Property window.

23. Click OK to close the Set Job Properties window.

24. Click OK to close the Advanced Routing Options page.

25. Click Finish.

26. Click Next on the Specify the Actions to take for this Rule page.

27. Click Finish.

17-3-2-3 Configuring TeleForm to work with Universal Output

1. Navigate to the directory where the ScriptAPI.cfg file is located:

Windows 7:
C:\ProgramData\Cardiff\TeleForm\scripts\AddIns

2. Modify the ScriptAPI.cfg file. The “X” in “AddIn_X” needs to be changed to the next number in the 
sequence after the highest existing number in the ScriptAPI.cfg file. In most cases for new installs, 
this will be “7” as shown in the example below.

AddIn_X.GUID={044CD12D-6426-4C25-8874-5DF94C559BBB}

AddIn_X.Name=XML Batch Search

AddIn_X.DLL=

AddIn_X.RegCmd=

AddIn_X.Enabled=1

AddIn_X.InstallType=0



162

Software integrations

For example:

AddIn_7.GUID={044CD12D-6426-4C25-8874-5DF94C559BBB}

AddIn_7.Name=XML Batch Search

AddIn_7.DLL=

AddIn_7.RegCmd=

AddIn_7.Enabled=1

AddIn_7.InstallType=0

3. Once the above changes are made, start TeleForm Designer and go to the ScriptingAPI tab on the 
Utilities > Configuration dialog.

4. Confirm that XML Batch Search is listed and enabled:

5. To configure the input method, go to Utilities > Connect Agent Setup > 7. Xml Batch Search.

6. Enter a path to a directory matching the one in the Universal Output Properties.

7. Continue with the following procedures (Configuring Ghostscript with TeleForm through Configuring 
the form).
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Configuring Ghostscript with TeleForm

1. Download gs905w32.exe and install it.

2. Once installed, configure TeleForm to use Ghostscript by editing the WKS file in this folder:

c:\program data\cardiff\Telefrom\profiles

NOTE:  For more information on configuring TeleForm for Ghostscript, contact TeleForm Support.

Outputting a job to TeleForm

To output a job to TeleForm, you will first create a TeleForm job that matches the HP CR JobID, as 
described in the procedure below.

NOTE:  The JobID in HP CR should be hard coded to = HPCR. This is based on the Teleforms.xsl file in 
the samples directory. The batchID must = ““.

1. Open the TeleForm Scan Station.

2. Select File > Job Configuration.

3. On the Job Configuration page, select New. The Job Properties page is displayed.
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4. Enter HPCR as the Job name.

If you have custom fields, click the Custom Fields tab and enter information, as applicable, in the custom 
fields. (This is not required by default.)
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Creating a sample form

1. Open the TeleForm Designer.

2. Select File > Templates.

3. Under Sample Forms, select a form.

4. From the Forms menu, select Activate.

NOTE:  Activating a form locks the image in place for zonal OCR and structured forms recognition.

Testing

1. Scan a job to the destination that matches the rule that was created.

2. The message should arrive on the shared directory with the XML file and the scanned image in PDF 
format.

3. Open the XML and verify that the format is correct.

Enabling TeleForm

1. Open the TeleForm Reader. This is the software that picks up the files and reads the forms.

2. Verify that the files were picked up from the directory specified.

3. Open the TeleForm Verifier.
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If you do not see the new job, click the Refresh button.

NOTE:  There is no time or date field by default. The only way to know this is your job is to look for any 
custom fields that may have been passed over with the job.

4. Highlight the job and click Process. This will open the job and display the scan.

Sending a form from TeleForm back to HPCR

You can set a form to feed back to a directory that the HPCR server is monitoring.

Configuring the form

1. Using the TeleForm Designer, open the form that will be used for scans:

a Select File > Templates > Sample Forms.

b Open the form you plan to use.

2. With the form open, select Form > Auto Export Setup.
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3. Click the New button and select Capture to Directory (VB.NET) from the drop-down in the Table 
Format field. This will capture an image file.

4. Click the File Export tab.
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5. Enable Export files and enter a directory that the HP CR Universal Input connector can access.

6. Repeat Steps 3 through 5 and select XML (C#) as the format. This will create an XML file.
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7. On the Fields tab, select the fields to export in the XML file.

8. Save the form when complete.

17-3-3 Enabling HP CR Universal Input

17-3-3-1 Creating a Universal Input connector

1. Click Start > All Programs > HP Capture and Route > HP Capture & Route Server 
Administrator to open the HP CR Server Administrator.

2. In the console tree, click Connectors > New HP Capture and Route Connector for > Universal 
Input. The Server Address page opens.

3. Click Next. Alternately, if you want the connector to run on a remote server, click Remote Server 
and enter the server name. Click Next. The Display Name page opens.

4. Enter a descriptive name and click Next. You are prompted to specify the folder to scan.

5. Click Browse and select the folder to scan.

6. Click Next. The connector is configured and added. The Congratulations page opens.

7. Click Finish.

The new Universal Input connector appears in the details pane. 
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17-3-3-2 Enabling XML translation

1. Click Start > All Programs > HP Capture and Route > HP Capture & Route Server 
Administrator to open the HP CR Server Administrator.

2. In the console tree, click Connectors. All connectors in the environment are listed in the details 
pane. 

3. Double-click the Universal Input connector to open the Properties page.

4. Click Folders.

5. Select the folder that is listed and click Properties. The New Folder page opens.

6. Select the Enable XML Translation option and click Add. The Enter Extension page opens.

7. Enter:

*.xml

8. Click OK to close the page.

9. Click OK to save your changes and close the New Folder page.

Now you can copy the TeleformsIn.XSL file to the Universal Input folder:

1. Browse to:

C:\Program Files (x86)\HP\HPCR\Samples\Universal Input

2. Copy the file TeleformsIn.xsl to the folder specified for the Universal Input connector.
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A Upgrading HP CR v1.4.0 to HP CR v1.5.0

Upgrading your current version of HP CR involves several steps, as detailed in this appendix:

Backing up the database (175)

Cancelling messages in the In Process queue (176)

Backing up the templates (176)

Uninstalling clients (176)

Uninstalling device clients from HP CR Server Administrator (177)

Deleting device clients and the Default group from the HP CR Server Administrator (177)

Running the server installation on the HP CR v1.4.0 system (177)

Installing clients (178)

Complete all of the procedures in this appendix in the order in which they are presented.

A-1 Backing up the database
Before you upgrade your current version of HP CR, you must back up the database. To back up and shrink 
the database:

1. Log in to the system that has the HP CR Server database.

2. Click Start > All Programs > Administrative Tools > Services.

3. Locate all HP Capture and Route services.

4. Right-click each service and click Properties from the drop-down menu.

5. On the Properties page, go to the Startup Type section and select Disabled from the drop-down 
menu.

6. Stop all HP Capture and Route services.

7. Using the Task manager, verify that all HP CR processes (beginning with Om*) are stopped.

8. Click Start > Run to open a Windows command prompt.

9. Back up the database using instructions provided by Microsoft in:

http://msdn.microsoft.com/en-us/library/ms130214(SQL.90).aspx

If necessary, change the name of the database while backing it up. You can also change the name 
of the backup file and the file path.

10. Locate the HP CR services and set the Startup Type to Automatic.

11. Start all HP CR services.
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A-2 Cancelling messages in the In Process queue
When preparing for the upgrade, you must wait for all messages to complete or cancel all messages in the 
In Process queue.

NOTE:  Any message located in the In Process queue at the time of the upgrade fails to compose. This 
is indicated in the message journal.

You must also notify HP CR users that they cannot send documents and faxes until the server upgrade and

configuration is complete. It is recommended that you upgrade the server during off hours or when the 
volume of documents traffic is low.

A-3 Backing up the templates
The setup program for the server upgrade overwrites all the files in these directories. Before you upgrade, 
you must back them up prior to running the server upgrade.

To backup your templates:

1. Make a backup copy of the Templates directory. The Templates directory is located in:

C:\Program Files (x86)\HP\HPCR\Languages\ENU\Notifications

where C: is the drive where the HP CR Server is installed.

NOTE:  “ENU” in the path above is an example of a default language used by the system. Other supported 
languages are in separate directories. When navigating to the Templates directory, go to the Languages 
folder, select the language you use, and create a backup of the templates for that language.

2. Make a backup copy of the Embedded Directives directory. This directory is located in:

C:\Program Files (x86)\HP\HPCR\Languages\ENU\EmbeddedDirectives

where C: is the drive where the HP CR Server is installed.

NOTE:  These directories contain cover page templates, Routing Sheet templates, and notification 
templates for your server.

A-4 Uninstalling clients
HP CR v1.5.0 requires that all previously installed client programs are uninstalled. To do so:

1. From Control Panel > Programs and Features, select Uninstall a program.

2. Continue to uninstall specific clients as described below.

Uninstalling Embedded Device Client for HP OXPd v1.4

1. Select the Embedded Device Client for HP OXPd v1.4.

2. Select Uninstall from the menu bar.

3. After uninstall is complete, verify that the OXP1.4 directory has been removed from:

C:\Program Files (x86)\HP location

4. Delete any folder that remains.
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Uninstalling Embedded Device Client for HP OXPd v1.6

1. Select the Embedded Device Client for HP OXPd v1.6.

2. Select Uninstall from the menu bar.

3. After uninstall is complete, verify that the OXP1.6 directory has been removed from:

C:\Program Files (x86)\HP location

4. Delete any folder that remains.

Uninstalling HP Capture and Route Web Client

1. Select the HP Capture and Route Web Client.

2. Select Uninstall from the menu bar.

3. After uninstall is complete, verify that the Web Client directory has been removed from:

C:\Program Files (x86)\HP location

4. Delete any folder that remains.

NOTE:  In order to access new features for the HP CR End User Interface, the client should be upgraded 
immediately after upgrading the server.

A-5 Uninstalling device clients from HP CR Server 
Administrator

1. Launch the HP CR Server Administrator > Select Devices > Default. The list of installed devices 
appears in the results pane.

2. Right-click on the device and select Uninstall.

3. Repeat these steps for all installed device clients.

A-6 Deleting device clients and the Default group 
from the HP CR Server Administrator

1. Launch the HP CR Server Administrator > Select Devices > Default. The list of installed devices 
appears in the results pane.

2. Right-click on the device and select Delete.

3. Right-click on the Default group and select Delete.

A-7 Running the server installation on the HP CR 
v1.4.0 system

To upgrade the server:

1. Close all applications on the server.

NOTE:  If you are upgrading an HP CR Server Cluster, you must manually stop the Cluster Services prior 
to the upgrade, and then manually restart them after the upgrade completes.
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2. Navigate to the directory where you saved the download.

3. Run Setup.exe.

4. Click Next. The License Agreement page opens.

5. Read the license agreement. After scrolling to the bottom of the agreement, click the button beside 
the I Accept The Terms Of The License Agreement option.

6. Click Next. The setup checks the system for installation requirements and displays the results.

7. Review the results and click Next.

8. The setup requests logon credentials for the HP CR service account. Provide the logon credentials:

a In the NT Domain text box, enter the domain name.

b In the User Name text box, enter the user name.

c In the Password and Confirm Password text boxes, enter the password for the user.

9. Click Next. The Ready to Install page opens listing all the installation settings.

10. Review the installation settings. Click Next to begin the server upgrade.

The InstallShield Wizard upgrades the server. When upgrade is complete, you will see the 
InstallShield Wizard Complete page.

11. Click Finish to close the InstallShield wizard. The Server Configuration Wizard launches and shows 
the Welcome page.

12. Click Next. You are prompted to save the changes you made to the server configuration.

13. Click Finish.

The server configuration wizard saves your changes to the server configuration. The HP CR Server 
Administrator starts automatically.

NOTE:  If you are upgrading an HP CR Server Cluster, you must manually restart Cluster Services after 
the upgrade completes.

NOTE:  The HP CR v1.3.0 version of the Universal Output connector (previously called the XML Output 
connector) is neither supported nor updated by this release. If you were previously using the XML Output 
connector, you will need to manually enable the Universal Output connector and update any existing rules 
after installing the upgrade to HP CR v1.5.0.

A-8 Installing clients
Refer to Section 17 (153), the HP Capture and Route (HP CR) Embedded Device Client for HP OXPd 
Installation Guide, and the Online help for the administrator for installation and troubleshooting procedures.

http://www.omtool.com/documentation/hpcr/1.5.0/admin/index.htm
http://www.omtool.com/documentation/hpcr/v1.3.0/serverhelp/index.htm
http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf
http://www.omtool.com/documentation/hpcr/1.5.0/hpcrembeddeddeviceclient.pdf


B Installing HP CR in a Non-English 
Environment

HP CR End User clients (devices, HP CR End User Interface, HP CR Embedded Device Client, HP CR for 
HP OXPd 1.4 Client, HP CR for HP OXPd 1.6 Client, HP CR for Microsoft SharePoint, and iManage) have 
been localized for Simplified Chinese, French, German, Italian, Brazilian Portuguese, and Spanish. 
Installing HP CR in a non-English environment involves several steps, as detailed in this appendix:

Installing HP CR (179)

Troubleshooting (180)

Standard device buttons have been localized. Note, however, that the Administrator can modify the text as 
it appears on a device button. These buttons will not appear as localized unless the Administrator enters 
the text in the applicable language.

B-1 Installing HP CR
Complete the installation procedures in Section 3: Installing the HP CR server (11). Then, complete the 
configuration procedures in Section 4: HP CR Server Administrator overview and post-installation 
configuration (23).

B-1-1 Note about Routing Sheet templates
After installation, the HP CR server includes templates to allow for localization of each language that the 
server uses to process messages. The templates are located in the HPCR\Languages folder:

...\Program Files\HP\HPCR\Languages\ENU\Coverpages

When a Desktop Client (such as the End User Interface) contacts the server, it passes the local language 
to the HP CR server, which then uses the appropriate template based on the Client's language code. If the 
language code does not exist, it defaults to US English. 

In the case of English (Ireland), for example, the language code ENI may be found in the language directory 
because it was manually created. But, HP CR does not automatically include a matching template in the 
HPCR\Languages folder. If you are setting up the HP CR server for English (Ireland), copy Routing Sheet 
templates from the ENU (US English) folder into the ENI folder.

B-1-2 Application pool for the End User Interface must be 
changed when installing on a non-US operating system

1. Open Internet Information Services (IIS) Manager on the server where the End User Interface was 
installed. 

2. Browse to Application Pools.

3. Select WebClient_Pool.

4. Select Advanced Settings on the Actions Pane.

5. Locate the Identity property under Process Model.

6. Click the ellipsis (...) next to NetworkService.
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7. Select Custom account.

8. Click Set.

9. Enter the domain and user name of the HP CR Service Account (domain\username).

10. Enter the password.

11. Click OK on the Set Credentials page.

12. Click OK on the Application Pool Identity page.

13. Click OK to close the Advance Settings page.

14. Open the HP CR End User Interface to the test settings.

B-2 Troubleshooting

B-2-1 “Failed to save new object (0x80040e14)” message
This message may display when installing HP CR v1.2 to a Windows operating system that is set to non-
US/UK regional settings.

After the HP CR installation, a first-time wizard runs and attempts to create the default configuration, 
including implementing the default connectors. When the operating system that is set to non-US/UK 
regional settings, the numbering system often is altered to use commas as decimal points rather than 
periods. For example, in US regional settings, 100.00 is used to signify 100 with two decimal places. 
Throughout continental Europe, the value 100,00 (with a comma rather than a period).

Use of the comma conflicts with HP CR saving certain data to the database (including while creating a 
connector). A resolution is in development.

To work around this issue, set regional settings to US/UK on the HP CR server. These settings have been 
tested and confirmed to work.

B-2-2 Installing in an environment without Microsoft 
Exchange or Lotus Notes causes logon issues for the 
End User Interface

After installing the HP CR End User Interface to an environment without Microsoft Exchange, the user may 
not be able to log in to the End User Interface. An LDAP warning is displayed. The End User Interface is 
attempting to look up attributes from Active Directory that are not available since the Active Directory 
Scheme was not modified (as it would be by installing Microsoft Exchange). This is addressable through a 
configuration change.

1. On the HP CR server, open Windows Explorer and browse to:

HP\HP CR\Config\AttributeMaps

2. Open the Exchange.default.xml file in Notepad (or an xml editor).

NOTE:  Make a copy of Exchange.default.xml prior to changes. 

3. The Exchange.default.xml file is set to read only. This option must be removed before any 
changes can be made.

4. In Exchange.default.xml, find the Exchange 2000 attributes section.
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<!--
Exchange 2000 attributes

-->
<Attribute>

5. Remove (cut) the trailing --> 

The section should appear as:

<!--
Exchange 2000 attributes
<Attribute>

6. Paste the --> after the </Attribute> line in the file so that it looks like this:

<!--
Exchange 2000 attributes
<Attribute>

-->
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